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Geomet Version Comparison Chart

Geomet operates in different levels designed to match your inspection needs.
These levels are known as:

• Geomet Junior
• Geomet Junior Plus
• Geomet 101
• Geomet 301

Geomet Junior

Geomet Junior is the entry-level full 3D-inspection system of the Geomet series,
yet it is packed with most of the functions needed for basic inspection. It favors
one touch access to all basic geometric elements in addition to a highly visible set
of icons on the screen for intuitive measuring without extensive training. Ideal for
use with touch screen applications. Geomet Junior includes a powerful set of Part
Coordinate System (PCS) generation tools that Geomet is famous for. Geomet
Junior is limited to one PCS and one qualified stylus. Geomet Junior is included
with the purchase of all Helmel manual Coordinate Measuring Machines.

Geomet Junior Plus

Geomet Junior Plus expands Geomet Junior by expanding support for unlimited
stylus qualifications, unlimited part coordinate systems and part program runs.
This option provides full inspection tools to support full 3D inspections in a
production environment. It does not provide graphical support, which is reserved,
for 101 and 301 levels.

Geomet 101

Geomet 101, our most popular package, offers great flexibility for inspecting
parts in the lab or on the production floor. The graphical area on the right side of
the display generates a pictorial representation of the measured features which
serves as a visual guide for part programs and as a link to the final inspection
results. Program writing is done in the self-teach mode, editing is easy and
efficient. Geomet 101 includes a full suite of reverse engineering tools. The
GeoPlus option expands Geomet 101 to include powerful features such as Vector
Point, customized tagging for printing and exporting and analytical tools for
circular features. Geomet 101 is designed for the production environment where
obtaining and tracking numerical solutions is preferred.

NOTE: Keep current with the latest
changes in Geomet by visiting:

www.geomet-cmm-software.com
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Geomet 301

Geomet 301, our most advanced system, offers the sophisticated user unbridled
measuring power with the typical user friendliness of Geomet. It contains all the
power of Geomet 101 and a host of other analytical tools to review and
manipulate your part inspections. The time proven and inherent quality of the
Geomet algorithms guarantee meaningful results when creating new and difficult
relationships out of measured features and PCS's. Geomet 301 offers an optional
expansion package to unlock the power of surface point analysis against a CAD
model. This power allows the user to align the CAD model with the part to be
inspected. Then capturing of data points can be calculated against the model to
obtain position within a profile zone.

Geomet Comparision Chart

Due to its dynamic natural, the full comparison chart can be viewed on the
Geomet web site at:

http://www.geomet-cmm-software.com/KB/Chapter1/KB10091.htm

This chart details the differences between the various levels of Geomet.
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Geomet Junior Installation Guide - Introduction

Summary of basic steps

1. Uninstall the current version of Geomet.
2. Install the new Geomet Junior.
3. Install the Crypkey license driver.
4. Run Geomet Junior and Obtain Site Code.
5. Contact Helmel Engineering for the GeoSecure Code
6. Enter the GeoSecure Code to activate your Geomet products.

IMPORTANT: Changes to the Protection Device

With the introduction of Geomet version 6.66, the new protection scheme for the
Geomet family of software incorporates the Crypkey software license system.
Earlier versions of Geomet required the use of a hardware “dongle” that plugged
into the parallel port. This protection dongle will only be required if you are using
GeoCAD. Once Geomet version 6.66 is installed and running, the hardware
dongle should be returned to Helmel.

The Crypkey software protection scheme utilizes information from the PC to
generate the Geomet Junior authorization codes. The codes are unique to your
computer system, and cannot be used on another system. The system will run with
Windows 98 SE and Windows 2000/XP. Windows 2000/XP systems need to have
the Crypkey license installed and running as a Windows service. On a Windows
98 SE system, the protection device runs as a system driver, not a service.
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The Geomet Junior Installation Program - Summary

The Geomet Junior installation program will install Geomet Junior, GeoClean,
GeoStat, and Gage R&R. When Geomet Junior has been authorized, your GeoStat
and Gage R&R will also be authorized if those options have been purchased. Both
GeoStat and Gage R&R can be authorized without enabling Geomet Junior, for
stand alone cases in which a PC separate from the CMM is to be used for data
analysis.

Microsoft Direct X

Geomet Junior uses Microsoft DirectX for sound and image support. The
installation process will verify the current installed version and determine if an
upgrade is used.

Additional Drivers and System Support Files

Driver and System Support files (*.sys, *.inf and *.ocx) for all Geomet Junior
operations are installed. Changes have been made to the CMM interface drivers.
Previously there was an entry in the Windows Registry that no longer is required.
The new CMM drivers are registered with the Windows System. The installation
process will guide you to setting up your interface.
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Before Installing Geomet Junior

Uninstall Previous Geomet Versions

Before you run the installation program, it is important that you uninstall all
existing Geomet related programs. This includes GeoStat and Gage R&R. Use the
Control Panel tool provided in Windows to uninstall the Geomet software. In the
example below, we show the Control Panel on a Windows XP system.

Windows XP Control Panel

Locate the program Add or Remove Programs and start that application by
double clicking. A listing of all programs for which Windows has uninstall
options will be listed. Locate the Geomet listing, see figure 2, and select the
<Remove> button.

Windows XP Control Panel

You will be asked to confirm that Geomet should be removed. Answer by
accepting <Yes> and Geomet and all associated program files will be removed.

The uninstall process does not remove any Windows registry settings, inspection
programs, library pr stylus database files associated with Geomet. Therefore, the
updated Geomet will retain the preference settings previously active. We
recommend as a normal operating procedure that you always make a backup copy
of your inspection part programs. If required, repeat the uninstall process for
GeoStat and Gage R&R programs.
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Installing Geomet Junior – Step-by-Step Guide

To install Geomet Junior, place the CD in your system’s drive. This CD does not
contain an auto run option and you should open and view the contents of the CD
with Windows Explorer or similar method. Please ensure all programs are closed
before performing the installation. On the root directory, there are several folders
and text files.

Geomet Junior Installation CD Root Directory

Step 1 – Readme.pdf

Before you begin the installation please take a quick review of the Readme.pdf
latest instructions for any changes to the installation process not covered here.
Should your system not have Adobe Acrobat Reader installed, please see the
section on installing the Acrobat Reader later in this document.

To start the Geomet Junior installation, double click on the file setup.exe. The
setup routine will launch and guide you through the required steps.

Step 2 – Welcome to the Installer

This first step is the welcome screen for the installer, press <Next> to proceed.

Step 3 – License Agreement

This step requires that you have read and agreed to the terms and conditions in
regard to using Geomet Junior.

Step 4 – Customer Information

Complete the required fields as appropriate.

Step 5 – CMM Interface

Choose the CMM Interface as noted on the Geomet Junior Software Security
Code sheet.
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Step 6 – Custom Setup

Press the <Next> button to accept the defaults. By default all help files and driver
files are installed. You can choose to remove these files from the installation.

Step 7 – Ready to Install

The final step, when accepted by pressing the <Install> button, will begin the
installation of Geomet Junior to your system. Installation also installs the files
necessary for the uninstall process.

Once completed, the installer will notify you of the success of the installation
process. Should any errors occur, you will be notified. The most common error
noted has been leaving Geomet Junior active (open) while attempting to upgrade.
This will cause an error and the installation process will fail.
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Installing the Crypkey License Driver

Before Geomet Junior version 6.66 can be authorized, the Crypkey license service
needs to be installed and running on the computer. Open GeoClean through the
Windows⇒Start menu and locating:

[All Programs⇒HelmelEnginering⇒GeoClean].

When GeoClean is displayed use the drop-down menu to choose:

[Authorization⇒Install Authorization Service]

GeoClean Install Authorization Service

This will install and start the Crypkey license service. Three files are needed for
the service, and these are installed in:

c:\ Program Files\Helmel Engineering\Geomet 101

The files installed are Setupex.exe, cks.exe, and wckserve.exe.

To check if the Crypkey license service is working properly on a Windows XP or
Windows 2000 system, open the Control Panel and choose the Administrative
Tools function. Open the Services shortcut, and find the Crypkey License. It
should be listed as Started and Automatic.

Windows 2000/XP Services

If the Crypkey license has not started in the Services listing, check the file
setupex.xco also located in the Geomet 101 folder. It will contain either the error
code, or ‘0’ if the Crypkey license was started successfully. For Windows 98 SE,
the Crypkey license will be initiated each time needed, and there is no check in
the Windows Control Panel.
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Authorizing the Geomet Junior Software

The authorization process for Geomet Junior will also provide the authorization
for both GeoStat and Gage R&R. Unlike previous versions, GeoClean no longer
has the responsibility for the authorization process. When launching Geomet
Junior v6.66 the first time, a message will indicate that the authorization needs to
be established. Click the <OK> button to open the authorization dialog, as seen
below.

Geomet Junior Authorization Screen

The Site Code is automatically generated by the Crypkey License service and is
specific to your PC. This Site Code needs to be sent to Helmel Engineering so that
your GeoSecure Code can be generated.

It is the combination of Site Code and GeoSecure Code that will authorize the
Geomet Junior software. Each time the Geomet Junior Authorization screen is
displayed, a new Site Code will be generated. Since the Site Code must match the
GeoSecure code, do not close the Geomet Junior Authorization dialog before
entering the matching GeoSecure Code. If the dialog is closed, a new Site Code
will be needed.

Site Code Copy Button GeoSecure Code Paste Button

Copy the Site Code and send it to Helmel Engineering using the Geomet web site
Authorization form:

http://www.geomet-cmm-software.com/Authorize.htm

Please include the Copy of the Site Code (Edit⇒Paste) into the Authorization
Form and include your Name, Phone Number, CMM Serial Number (99-99)
and the return email address.
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We will contact you as soon as possible with a GeoSecure Code. When you
receive the return email, highlight the supplied GeoSecure Code and copy
(Edit⇒Copy) and Paste it into your Geomet Junior Authorization dialog. Press
<Authorize> after the GeoSecure code has been entered.

If your email service is not on the same computer as the Geomet Junior system,
copy the GeoSecure Code and enter it manually.

Once Geomet Junior has been authorized, click the <OK> button to continue
starting Geomet Junior. To check the enabled options while Geomet Junior is
running, press Ctrl-Alt-U from the main screen of Geomet Junior to show the
Geomet Junior Authorization dialog. Should you want to change your options,
you can generate a new Site Code from this dialog, which can be sent to Helmel
Engineering in order to change the enabled levels and options.

If the authorization of Geomet Junior included the options for GeoStat and Gage
R&R, these programs can be opened at any time. Otherwise when attempting to
open the program, an authorization screen similar to Geomet Junior’s will be
displayed, requiring a GeoSecure code to enable the program.

 Switching CMM Interfaces

By default, the Geomet Junior installation creates a
folder in the Program Files\Helmel
Engineering\Geomet 101 folder named Interfaces.
This folder will contain the CMM interface (Table
Control file) for each of the different systems. To
switch from the currently registered interface,
close Geomet Junior, open GeoClean, and from the
Registry pull-down menu, choose Select Interface.
Choose the desired interface from the pull-down
list, and hit the <OK> button. Answer <Yes> to the confirmation screen, and
GeoClean will register the appropriate interface with Windows. Windows will
provide a message indicating the success of the registration. Open Geomet Junior
to see that the new interface has been properly configured.

Since Geomet Junior uses the interface registered with Windows, and ignores any
setting of the interface in the Geomet 101 SYSTEM SETTINGS registry,
GeoClean will only register the new interface with Windows. The registry will be
unchanged.

Installing Acrobat

Run the AdbeRdr60_enu_full.exe file located on the Geomet CD under the
ACROREAD\Installers folder.
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Geomet Junior System Options

Keyboard: F9

Menu: System ⇒ System Options

The Geomet Junior system has many options and system characteristics that
control the behavior of the system. These include optional hardware, file
locations, default features setting to name a few.

Feature Characteristics

Th Feature Characteristics provides access to
establishing the minimum number of data points
for all multi-point features. For example, launch
the circle measurement function and the default
number of data points are provided, in this
example 4. If your inspection process require that
you need more than 4 data points on every circle,
enter a new value as the default.

It is recommended that on a multi point feature,
the minimum number of hits should be set 1
greater than the minimum allowed for solving for
that feature. This allows for form fit testing to
ensure the data points created a sound feature. The
table below lists the minimum and recommended
number of data points required in Geomet Junior
for a feature.

Feature Type Minimum Recommended
Line 2 2

Circle 3 4
Plane 3 4

Cylinder 6 6
Cone 6 7

Sphere 4 5
NOTE: On Cylinder and Cone features, Geomet requires mimimum + 1 for its internal algorithim used to solve the feature.
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Form Limits

Multi-Point Error Limit
This value is used during the measuring process to validate the form of a multi-
point feature before it is committed to the inspection report. For example, when
measuring a circle, it is expected that the circularity is better than the form error
limit. If during the measuring process the circularity exceeds this form limit
(0.001” by default), then a warning is provided to allow the operator to accept or
re-measure the feature. This validation process helps to minimize errant data
points or poor fitting features.

Default: 0.001"

Skip Multi-Point Check
When NOT checked, Geomet Junior performs the Multi-Point Error Limit test on
all measured multi-point features.

Enable Auto Sensing
Default: Not Checked. When checked Geomet Junior reconfigures to sense for the
current probe direction vector, see Auto-Direction in Chapter 8 for a complete
description. This option is only available on some CMM interfaces that allow
time based monitoring of CMM motion.

Default: Checked

Non-Linear Compensation
The use of non- linear compensation is set by the factory or by the technician
performing calibration on the CMM. This option involves the mapping of your
scales on the X, Y, and Z-axes. See Technical Note #2 for enhanced description.

Default Toggle State

The Default Toggle State page controls the reporting formats used at startup or
globally changed during the self-teach mode.

Reporting Characteristics
Select the small button next to the reporting characteristic.

Description Option 1 Option 2
Unit of Measure Inch Metric

Angular Reporting xx.xx° dd mm ss°
Reporting Format Cartesian Polar

Activate these changes for current inspection

By selecting this option, all selections in Report States will activate immediately.
Under normal conditions, Report States control the behavior of the inspection
when it creates a new inspection report.
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CMM Scale Compensation

Coordinate Measuring Machines utilize scales that are mounted to each axis of
motion will require compensation. This compensation will correct for any linear
deviations identified during CMM calibration.

A certified Master Scale or Laser system is used to compare against the reported
position from the CMM Digital Readout. This deviation can then be
mathematically corrected. This information must be supplied to your CMM
software to properly measure. There are two main types of scale comparison
technologies.  These are Linear and Non-Linear Compensation.

For additional information refer to Technical Note #2, Inherent Errors located in
Appendix 1.

Linear Compensation

Linear Compensation is a single correction value used to compensate the full
length of travel. For example; if your CMM has a Y-axis travel of 10.0”, you
would test the reported position at its extent against the master scale.

Position Reported by Laser CMM Digital Readout Compensation value
10.00000 10.00235 0.99976505

The value, 0.99976505, would be entered in the Linear Setup Tool for the Y-axis
and that value becomes the multiplier for all positions. Geomet Junior will use the
following formula to compensate for position:

XDRO Reported Value * XCompensation = XCorrected Position
YDRO Reported Value * YCompensation = YCorrected Position
ZDRO Reported Value * ZCompensation = ZCorrected Position

All reported values that pass into Geomet Junior will be passed through the Linear
Compensation tool prior to being used for any calculations.
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Activating the Linear Setup Tool

Keyboard: <Alt + Ctrl + shift + F2>

Taking a Tour of the Linear Setup Tool

The controlled data is shown in the upper section of the tool where the entered
and calculated axis values are shown.

Calculate Compensation

When performing a calibration, there are three values per axis. Two of which
must be entered and the third will be calculated. In the example above, the
operator enters the Reference Length and reported Measured Length. The third
value, Compensation Value will be calculated.

Reference Length:
This is the reported position from the Master Scale or Laser.

Measured Length:
This is the reported uncompensated Digital Readout value scale position.

Compensated Value:
The compensated value is the result of Reference Length / Measured Length.

Position Comparison Group

Selecting the Active Axis
In this area choose the axis you wish to calibrate.
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No Compensation
This data field shows the current position directly from the CMM scales with no
compensation applied.

With Compensation
As the name suggests, this is the reported position with the current compensation
applied. This is the result of (Using the x-axis as the example):

XNo Compensation Position * XCompensation = XWith Compensation Position

Difference
This reported value is the spread between the No Compensation and With
Compensation positions.

Min, Max, Spread
These values will update when the <Start / Stop Test> button has been pressed.
This reports the difference value while moving the CMM along the selected axis.
Use it to determine the total spread that will occur over the full length of travel.

Functions

<DRO>
Toggles the visible state of the standard Geomet Junior Digital Readout.

<DRO Xfer>
Copies the current position into the Measured Length data field. This value is the
un-compensated position shown in the No Compensation data field.

<Zero Axis>
Sends an offset position to the internal counter that changes the current position to
0.000. This is used to zero the current position and is done in conjunction with the
setting of the zero position for the Master Scale or Laser making both devices
equal at that position.

When the zero option has been applied to an axis, there is a visual reminder,
“Zero Set”, next to the axis.

<Clear Zero>
Removes a previous zero offset value from the selected axis.

<Update Compensation>
This command transfers the calculated Compensation Value from the Setup Tool
into Geomet Junior. This is used when displaying the Geomet Junior DRO for
comparison. This command is optional.
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<Enter Compensation Factors>
This command is a push-on / push-off button. It toggles the disabled state of the
Measured Length and Compensation Values columns. When providing the
Reference Length and Measured Value, this button is off which will disable the
Compensation Value. It is used when only the Compensation Value is provided
for calibration.

<Start / Stop Test>
The test is designed to capture the minimum, maximum and spread for the entire
length of the selected axis. To use, start the test by pressing the button once. A
message will appear indicating the test is active. Move the CMM along the
selected axis. The test values will display providing the variations along the
travel.

Setting the Compensation Value

The process of determining the compensation values requires the use of a Master
Scale or Laser system.

Master Scale
If used a master scale, a reader head is mounted on the CMM probe bar and the
certified scale is mounted inline with the axis to test. The reader head is adjusted
to read the scale over the full length of travel. Once the alignment has been
completed, move the CMM back to a starting point. For example in the Y-axis,
move the CMM to its most –Y position.

Zero the digital Readout that is used to report the position along the master scale.
In the Linear Setup Tool, ensure the correct axis is elected (Y Position) and press
the <Zero Axis> button. This action will result in the master scale and CMM
readout both reporting 0.000.

Move the CMM slowly in the +Y direction until you reach the furthest position.
The master scale will report a linear position, which is then entered into the Ref.
Lgth column for the y-axis. In the No Compensation position field you will find
the CMM readout value. Transfer this value into the Meas. Lgth column by
pressing the <DRO Xfer> button. When this is accomplished, the compensation
Value is automatically updated and the updated position in the With
Compensation field should match the master scale position.

Repeat this procedure for each axis. To verify the compensation value, use the
<Start / Stop Test> function.

Using a Laser
The procedure is the same as described for Master Scale.
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Non-Linear Compensation Tables

This form of compensation provides a more accurate solution for determining
scale corrections using many segments over the axis of travel. A typical scale
when mounted to the CMM can stretch and shrink over its length. The
compensation required between 10.000” - 11.000” may be different than between
20.000” – 21.000”.

The method to determine the compensation is done by taking position readings
along the full travel, for example, every 1.000”. A table is built using the Master
Scale or Laser position and the reported CMM position.

Non-Linear Setup Tool

Non-Linear Setup Tool

Activating the Non-Linear Setup Tool requires that the Non-Linear Compensation
flag be checked in the [System Option].

Activating the Non-Linear Setup Tool

Keyboard: <Alt + Ctrl + shift + F2>

Taking a Tour of the Linear Setup Tool

Calibration Data List
The list of Master Scale or Laser readings along with its corresponding DRO
positions are shown under Calibration Data. This list does not show the
compensation value, which is calculated as:

XReference Value / XDRO Reported Value = XCompensation Value
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Selecting an entry in the data list will bring the position values down into edit
controls labeled DRO Value -> and Laser Value ->. From the edit controls
changes can be made when performing or editing a calibration.

<Append>
When building the data list, new entries are added by entering the reference and
DRO positions in the Step Value Group. Pressing <Append> will then transfer
that data into the list. This list performs a sort to keep the list in linear order.

<Delete>
Removes the selected position from the data list.

<Update>
When a position record is selected, changes can be made to the laser and DRO
position values. Once the changes have been completed, press <Update> to
transfer the changes into the data list.

<Graph>
Displays a graph of the position difference values. This graph can be printed for
the current axis or for all three axes.

<Disable Comp>
When <Disable Comp> is active, Non-Linear compensation is deactivated and the
CMM will use Linear Calibration. When pressing, the Non-Linear tables are
saved to the data file.

<Xfer DRO Val.>
Moves the current position displayed in the Active DRO Group into the edit
control labeled DRO Value ->.

Motion Jogger Group

The Motion Jogger Group is available on CMMs that have a motion controller.

<Abs. Move>
Positions the CMM under DCC to the absolute position entered in Jog Value.

<Rel. Move>
Positions the CMM under DCC to the relative step position entered in Jog Value.

<Motor On/Off>
Toggles the state of the motors between On or Off.
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Geomet Junior Toolbar

Geomet Junior provides an iconic toolbar for
access to the most common functions. This
toolbar contains validation control that will enable
or disable certain features based on the last
operation Geomet Junior has completed.

Open existing inspection file.

Save-As current inspection file.

Prints the current inspection report.

Launches the System Options Tool.

In standard Junior mode, launches the calibration tools.
In Junior-Plus mode, launches the Stylus Manager.
Activates the Report Header Tool.

Orientation Tool.

Alingment Tool.

Origin Tool.

Establishes an Interin Coordinate System (ICS⇒PCS).
Rotate the existing PCS around one axis.

Translate the existing PCS in XYZ coordinates.

Available in Junior-Plus. Activates the Recall PCS Tool.

Activates the Enter Text or Coomment Tool.

Point Measurement (1D, 2D or 3D).

Circle Measurement Tool.

Line Measurement Tool.

Plane Measurement Tool.

Sphere Measurement Tool.

Cylinder Measurement Tool.

Cone Measurement Tool.

Contrsct a Line from existing features.

Contrsct a Circle from existing features.

Contrsct a Plane from existing features.

Activate the GeoTol, Form Tolerance Tool.

Feature Bisect Tool.

Feature Intersect Tool.

Distance Tool.

Angle Tool.

Feature Recall Tool.
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Stylus Qualification – Geomet Junior

Geomet Junior is limited to qualifying one stylus tip. Geomet Junior also does not
support articulating, manual and motorized, probe heads.

The Qualify Ball Stylus is activated by:

Keyboard: w

Menu: Qualify->Qualify Ball Stylus

Qualify Icon

Geomet Junior will display the Qualify count down box

Capture the required number of data points around the reference sphere.

Set the default number of hits

All Geomet products default to 5 data points for the qualification process. To
change this value, there are two methods.

Activate the sub menu by right clicking on the Qualification count down box as
shown in the figure below.
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Select from the sub menu [Set Default Number of Points]. The Enter Values
dialog will appear where you can change the number of hits.

 The second method is too left-click on the sphere image. The Enter Values
dialog will appear where you can change the number of hits.

Setting the Reference Sphere Size

To change the size of the reference sphere, activate the qualification sub menu by
right clicking on the Qualification count down dialog.

Choose [Set Reference Sphere] from the sub menu. The data field below “Ref.
Sphere Size” will become active and you can enter a new value. When you have
completed entering the new size, press the < ↵ Enter > key on you keyboard
which will save the new size.

You can also change the Reference Sphere size when not in the Qualify mode by
selecting from the main menu:

Qualify ⇒ Reference Sphere

You will then be prompted to enter the new diameter of the Reference Sphere.
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Enter the Stylus Size Manually

To enter the Stylus diameter manually, from the main menu choose:

Qualify ⇒ Enter Diameter

Enter your new diameter and press <Ok>. NOTE: If using a cross hair generator
on a video camera as you stylus, enter 0.00 in the size.

Other Qualifying Options

Geomet Junior has the ability to Re-Qualify the existing stylus. This allows you
the ability to change your stylus to another size and to qualify that new stylus tip
against the reference sphere. Full help details can be found later in this chapter in
the Geomet Junior Plus section.
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Stylus Manager – Geomet Junior Plus Only

Geomet Junior maintains a database of known, qualified styli. Each stylus used is
qualified against a standard reference sphere to identify the size and MCS
location. Knowing the size and location allows Geomet Junior to properly apply
compensation to all measured features. Knowing the location allows the switching
of the styli between positions in a cluster.

Stylus Management is handled by the Stylus Manager that contains all the tools
necessary for qualifying, re-qualifying and choosing a stylus for use in measuring.
The configuration of all your stylus hardware is maintained in the System Options
on the Probes and Sensors page.

The Stylus Manager is activated by:

Keyboard: w

Menu: Qualify->Stylus Manager

Probe Qualification Process

After qualifying the first stylus, Geomet Junior maintains that position as the
reference position for the entire stylus database. When adding additional styli,
Geomet Junior maintains the location relationship between the newly qualified
stylus and the first stylus. This relationship is applied when setting any stylus
active and allows correct compensation for any qualified position, even in the
same feature, without loss of accuracy.
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Stylus Manager Sub Menu Tools

There exists a sub menu that can be called up to react directly with the list of
stylus records. To activate the sub menu, right-click in the list area and the sub
menu will appear.

Through the sub menu you have access to three functions. These are:

• Delete Stylus
• Duplicate Stylus
• Edit Label

All three functions work on the highlighted stylus, but only the Delete Stylus has
more than one feature. When a stylus is highlighted, the delete function will
delete only that stylus. When there are no stylus selected, the delete will clear all
stylus information from the database.
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Deleting Stylus from the Stylus Manager

Summary

Deleting a stylus will remove from the database all information regarding position
and size. Caution should be taken when deleting a stylus from the database.
Geomet Junior will mark any styli missing as Pre-Qualify when opening an
inspection that requires the deleted tip.

• Delete a single Stylus
• Delete all Stylus
• Remove all Pre-Qualified Stylus

Delete a Single Stylus

Step 1

Activating the Stylus Manager can be done through the use of the 'w' keystroke or
through the drop down menus [Qualify->Stylus Manager].

The Stylus Manager will display all current, qualified styli and pre-qualified styli.
The current active stylus is shown with an arrow located next to it.
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Step 2

Highlight the desired stylus to delete and click on the <- Delete Selected> button,
or press <Alt + S> on the keyboard. You will be prompted to confirm your
request. A message will appear to confirm the deletion of the selected stylus, click
on the <Ok> button to delete the stylus. NOTE: If you are attempting to delete the
primary stylus (#1), you will invalidate all styli in the database. A message will
prompt you explaining this before you delete.

Delete all Stylus

Step 1

Activating the Stylus Manager can be done through the use of the 'w' keystroke or
through the drop down menus [Qualify ⇒ Stylus Manager].

Step 2

With no stylus highlighted in the selection, click on the <- Remove All> button or
press the '-' (minus) key on the keyboard.  You will be prompted to confirm your
request. To confirm the deletion of all styli, click on the <Ok> button in the
message dialog.
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Remove all Pre-Qualified Stylus

Step 1

Activating the Stylus Manager can be done through the use of the 'w' keystroke or
through the drop down menus [Qualify->Stylus Manager].

Pre-Qualified stylus are inserted into the stylus database only when opening a
previous part inspection file that uses styli that are not currently part of the active
stylus database. For example, if a part inspection was done that required the use of
stylus numbers 1, 2, 3, 4, and 5 those references are stored in the part inspection
file. Should the current stylus database be changed to have only stylus numbers 1,
2, and 3 qualified and the part inspection file was opened, Geomet Junior would
insert stylus 4 and 5 and mark them as pre-qualified. You will not be allowed to
proceed with the inspection without first qualifying stylus 4 and 5.

However, should you want to just remove the pre-qualified stylus, the button
<Clean Up> will be made available.

Step 2

When there are 1 or more styli marked as Pre-Qualify, you can delete all of them
with the use of the <Clean Up> button.
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Duplicate a Stylus

Summary

To create a copy of an existing stylus can be accomplished with the Duplicate
Stylus command. This command is especially helpful when creating a stylus
database on manual friction style probing systems where the need to re-qualify
multiple positions are required.

Procedure

To duplicate a stylus, start by highlighting an existing and qualified stylus tip.
Right-click to activate the sub-menu and choose the [Duplicate Stylus] command,
see figure below. An exact copy of the highlighted stylus is created and is
appended to the Stylus database.

To see an example on the importance of this command, see Re-Qualify a Stylus.
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Labeling Stylus

Labeling an individual stylus is helpful in identifying its unique characteristics. In
Geomet Junior, when a new stylus is qualified, and by default, is given the next
available tip number. This is not very helpful in describing the characteristic of
the stylus. For example, the tip may be the "left tip" on a stylus cluster.

To attach a label on a single stylus, two methods can be employed. The first
involves the standard Windows interface where you highlight the desired tip by
left clicking once on the stylus under the Label column header. Then pause and
left-click on the stylus again, Windows acknowledges the second left-click, and
an edit box surrounds the current label and you can type directly into the Stylus
Manager list.

Should Windows not provide the edit label tool, you can activate the edit label
tool by selecting the stylus as described above and press the "l" <lowercase L>
key on the keyboard. This will start the edit process for that selected stylus. To
complete the labeling processes, press the <Enter> key on the keyboard, or
highlight another stylus.
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Basic Ball Style Electronic Touch Probe

This Qualification process is based on the hardware configuration consisting of a
ball stylus touch probe on an electronic probe head. This configuration is similar
to a Renishaw TP-ES or a PH1 with a TP2 probe body.

Step 1

To start the qualification process, activate the stylus manager by pressing the "w"
key on the keyboard or the [Qualify->Stylus Manager] from the drop down
menus. To add a new stylus qualification, press the <Next> button found on the
Stylus Manager. Note: For more efficient operations, the <Next> button is also
activated by pressing the <Enter> key on the keyboard.

Step 2

This step will prompt you to enter the qualification type. This describes the type
of stylus attached to your system. The choices are ball, taper, cylinder, video cross
hair and manually entered diameter. By default the qualification type will show
"Ball". To continue the qualification process, press the <Next> button on this
dialog or press the <Enter> key on the keyboard.

Step 3

The final step will prompt you to proceed capturing the data points required to
solve the qualification of the stylus.

We are prompted to capture the current default number of data points required. At
this time, capture the data points on the reference sphere and the count required
would descend until all data points have been captured.

The process used to capture the data points will influence the quality of the
solution. If you were to capture your data points close together, or with
inconsistent speed, there can be error introduced in the end result of size and
location, so try to capture points spread evenly around the calibration sphere with
consistent probing speed.
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We recommend that when using 5 data points, the first point should be taken on
the top of the reference sphere and the remaining 4 taken at the equator.

Should you require to abort a single data point that has been captured, press the
<F2> key on the keyboard and the required count of data points will increase as it
discards the last data point in the buffer.

Qualifying Ball Styli in Multiple Positions

This Qualification example is based on the hardware configuration consisting of a
ball stylus touch probe in different locations attached to one or more electronic
touch probes. One example would be a manual articulating electronic probe head
such as the Renishaw MIP. Another example would be a Cluster probe located on
an electronic probe with multiple ball styli installed.

The process of qualifying more than one physical location involves the same steps
as described above in Basic Ball Style Electronic Touch Probe. The first probe
should be qualified exactly as stated in steps 1-3. When the first probe has been
qualified, you will return to the main screen of the Stylus Manager. To add
another position on a cluster, or another location on an articulating probe, follow
steps 1-3 described above.

Geomet Junior will qualify the MCS location and size and assign the next stylus
tip number to the stylus database. The location it stores is the XYZ variation from
stylus tip number 1.

NOTE on Reference Sphere Location

On DCC style CMMs there is a "Home" position which is repeatable for inspection
results. The MCS origin is the Home position of the CMM. This allows adding
additional stylus positions to the current stylus database without loss of position.

On manual CMMs that do not offer a Home procedure, the origin of the MCS is the
location the CMM was at the time of power up, or the location when Geomet Junior
was launched. Therefore the origin position of the MCS is not reliable or repeatable.
When you qualify multiple positions, all qualifications should be done during one
session to ensure correct relationships between all the stylus centers. Should you
have to add positions after a system restart, you should always clear your stylus
database and add all positions required for your inspection..
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Entering a Known Diameter

The Stylus Manager provides a process where you can enter the known size of the
stylus manually. This is often done when using hard probes or when you desire to
enter a specified diameter.

Caution should be taken when entering the size manually. The ball center location
is not established and therefore can not be used with other qualified styli in the
same coordinate system.

A manually entered diameter will not equal the reported diameter of the same
stylus when qualified against the reference sphere. This condition is a result of the
touch probe pre-travel distance. When an electronic touch probe comes in contact
with the reference sphere, it must travel a small distance after contact until the
trigger is activated. This results in a smaller diameter than one measured with a
micrometer.

Step 1

To start the qualification process, activate the stylus manager by pressing the "w"
key on the keyboard or the [Qualify->Stylus Manager] from the drop down
menus. To add a new stylus qualification, press the <Next> button found on the
Stylus Manager.

Step 2

On the Qualification Type page choose “Entered” from the drop down list. Press
<Next> to proceed.

Step 3

On the final page, enter the known diameter size in the space provided.



Chapter 3 – Stylus Management

Helmel Engineering Products, Inc. Geomet Junior Training Handbook
www.helmel.com www.geomet-cmm-software.com

3-16

Stylus Multiple Tip Relationships

To ensure accurate and repeatable inspections, it is important to understand the
relationship between qualified stylus positions when you require more than one in
your inspection.

In your Stylus Database, the first stylus qualified is considered the primary or
reference position for all qualified styli. The first qualification will record the
center location in the MCS of the Reference Sphere and assign it to tip number 1.

All susequent qualifications will record the deviation to the primary tip. This
allows Geomet Junior to use multiple styli in a single coordinate system without a
shift in position. Geomet Junior also allows the use of multiple styli when
measuring a single feature such as a cylinder.

Therefore certain conditions must be met to allow safe requalifications and
modifications to the Stylus Database. The first rule is that any stylus can be
deleted, except stylus tip number 1. Should you delete stylus tip number 1, then
all styli should be removed and qualified again.

Re-Qualify a Stylus

Re-Qualifying a stylus updates the current stylus with a new size and MCS
location. Re-Qualification has two main functions, to validate the current size and
location of your qualified stylus, or to reposition the current stylus during the
inspection process using a manual indexing friction probe.

The use of the Re-Qualify command as a validation tool is useful when it is
necessary to perform checks on your stylus database. These validation tests would
look for damaged probes, worn stylus balls, movement of stylus clusters or any
other abnormal conditions that can adversely affect your inspection results. You
may want to create a Re-Qualify Stylus part program which will report and update
changes in size and location of the stylus.

Re-Qualifying during the inspection process can be used to extend the usefulness
of a friction style articulating probe head such as the Renishaw PH1 or PH8.

The Re-Qualification process can be done manually on a single stylus, or as part
of a motion program which can automatically update the size and MCS location
of all attached styli.

NOTE: In Geomet Junior, the following dialogs associated with Geomet Junior
Plus will not appear. When you request a Re-Qualify, you will be prompted to
capture the required number of data points.
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Re-Qualifying an existing Stylus

When you start the Re-Qualification process, the first step will show you the
previous stylus definitions, see figure below.

For example, if stylus number 2 was a ball style when created, this step will show
"Ball" in the Type control and you will not be allowed to change it. Press the
<Next> button to proceed to the next operation.

The final step will prompt you to capture the data points required. Once this step
has been completed, the Stylus Database will be updated with the latest size and
MCS location for the selected stylus.

Stylus Relationships

Stylus number 1 is considered the origin position for the entire stylus database.
The relationship between any stylus and stylus 1 is the MCS offset value in XYZ
values. This offset is applied in calculations when measuring features. By
knowing this offset value, Geomet Junior can measure a single feature with
multiple probe tip locations.

Therefore, when Re-Qualifying stylus number 1, all other stylus in the database
will be marked as "Pre-Qual". Each stylus tip will have to be Re-Qualified before
it can be eligible for use in measuring.
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Example Re-qualify Stylus Tips for Friction Probe Heads

One limitation of using a friction style probe head is that you can not return to the
same articulated position with any degree of accuracy. Geomet Junior allows the
various positions of the probe head to be used in the part program without
establishing new coordinate systems for every qualified stylus. This can be
accomplished by following these basic steps.

Assuming we are starting with no current stylus qualified, we will qualify the first
position for your inspection using the Stylus Manager as defined in Qualifying a
Stylus above. This will become Stylus Number 1 in your Probe and Sensor
Database.

Do not move the stylus, but qualify it again at the same location which becomes
Stylus Number 2.  You can also use the Duplicate Stylus command to create
Stylus Number 2.

Start your inspection with Stylus Number 2 as the active stylus. Do not start your
inspection with Stylus Number 1.  Proceed measuring features until it is required
to articulate the probe position. Reposition the probe and perform a Re-Qualify,
<Ctrl + w>, on the current stylus number 2. You will be prompted to capture data
points on the reference sphere. Once this operation has been completed, you can
return to inspecting new features without any loss of position. This re-qualify step
becomes part of your part inspection and during a program run, you will be
prompted automatically.

This can be done to Stylus Number 2 as many times as required to satisfy your
inspection needs. Since Stylus Number 1 was not changed, all styli starting with
number 2 and beyond can be used and re-qualified many times.

Should you have moved Stylus Number 1 and performed a Re-Qualify on it, all
known locations would have moved. This includes established Part Coordinate
Systems. The Stylus Database retains the reference sphere location in the MCS
based on stylus number 1. All Part Coordinate Systems also are referenced to
the MCS. Moving stylus number 1 will cause PCSs to move.

Note: This process can also be used when it is necessary to change styli on the
probe head. For example, you are required to install a stylus with an extension, or
install a small diameter stylus for use on selected features in your inspection.

TIP: When you want to rotate the probe head, or change the stylus to another
size, press the space bar which will "Disable" the probe preventing data points
from entering Geomet Junior. When you have completed the change, press the
space bar again and your probe will enable.
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Cautions:

Care should be taken when performing a Re-Qualification using a manual CMM.
The qualification process relies on the XYZ offset from the CMM Home position
for location of the reference sphere. That position is assigned to stylus number 1.

When you qualify the first stylus, Geomet Junior retains the location based on the
center of the reference sphere in the Machine Coordinate System (MCS). The
MCS has an origin point (X=0.0, Y=0.0, Z=0.0) that has been established either
with the power on position for manual CMMs or the Home position for DCC
CMMs. It is possible to have an established Home position on some manual
CMMs that have the Home option installed.

Additionally, Re-Qualification assumes the reference sphere has not been moved.
If the reference sphere has been moved, the Geomet Junior function
[Recover→Ref Sphere] should be done.

Re-Qualify Example

On the Geomet web site, you can find an example of a Re-Qualify program for
use on DCC style coordinate measuring machines. This help can be found at:

http://www.geomet-cmm-software.com/KB/Chapter4/KB10043.htm
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Point

Points are dimensionless locations in 3D space. Points have no size. The location
of a point is specified by its X, Y, and Z coordinates in a defined coordinate
system. There are many point types that Geomet Junior supports. These include
1D, 2D and 3D points.

Measured points consist of 1D, 2D and 3D style geometric elements. Keyboard
access to these points is done through the number keypad, see table below.

Keystroke 1D Point 2D Point 3D Point
1 -Z
2 -Y

3 + 2 XY IR
3 + 4 ZX IR
3 + 6 YZ IR
3 + 9 3D IR

4 -X

5 + 2 XY
5 + 4 ZX
5 + 6 YZ
5 + 9 3D

6 +X
7 + 2 XY OR
7 + 4 ZX OR
7 + 6 YZ OR
7 + 9 3D OR

8 +Z
9 +Y

IR = Inside Radius / OR = Outside Radius
Table 1, Keyboard Access
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1D Point

1D Points report 1D locations. There are six 1D point routines, designated ±X, ±Y
and ±Z PCS directions. Pressing one of assigned keys, see previous table,
prepares Geomet Junior to measure a single point on a planar surface. The report
consists of the location of the center of the stylus corrected by the stylus radius in
the PCS probing direction. Problems arise if the planar surface is not parallel to a
PCS base plane.

+X MCS Point +Y PCS Point

The illustrations above demonstrate a 1D-point measurement using the same
planar surface on the GeoWidget using two alignments. One based upon the MCS
and then referencing PCS 2. Although the stylus center is at the same XYZ
location in both cases, the calculated points P1 and P2 are quite different. P1 was
measured as a +X 1D Point and is calculated based on the probe radius correction
parallel to the X-axis of the MCS. P2 resulted from a probe radius correction
parallel to the Y-axis of PCS 2. This illustrates how measurements of a surface in
an unaligned PCS can produce erroneous results.

Single 1D Point measurements can only be used to determine the locations of
planar surfaces, which are parallel to the PCS base planes. Pairs of 1D Point
measurements on planar surfaces that are parallel to PCS base planes may serve to
determine the Distance between the surfaces or the location of the Bisector of
surfaces. Pairs of 1D Point measurements on simply skewed planar surfaces,
meaningless in themselves, may be used to define a Line on a surface or to Align
the current PCS to be parallel to the surface.

To measure a 1D Point, press the corresponding Point direction key and gather a
data point on your work piece. If you have Auto-Direction enabled, you will be
prompted "Measure Auto-Dir Point" and your approach vector to the work piece
will identify the probing direction.

Tolerancing of 1D Points is limited to Cartesian / Linear.

1D Points are available for use in building Part Coordinate Systems. Single 1D
points can establish the origin for a single PCS axis. For example: a +X Point can
establish the X axis origin. Two coplanar 1D Points can establish an alignment.
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Auto Direction Sensing and 1D Points
Using auto direction on 1D Points can lead to erroneous reported values if used
incorrectly. Auto direction relies on a smooth approach, from you the operator, in
capturing of a data point. The process of determining the approach vector
involves the CMM interface card (ProCounter, Tech 80 or PMAC) to maintain a
rolling IJK vector based on the last five reported values. These interface cards
update the current position in the MCS on a programmable time interval from 20
to 200 milliseconds.

Auto Direction Approach Vector

When you are approaching your work piece, it is required that you make contact
while remaining in a ±45° approach, see figure above. In this example, if we
remained in the approach zone we will capture a data point that will be reported
as a +Y point. If the operator did not remain in the approach zone the 1D Point
might report a + or - X Point from which we will have to correct the probe
compensation error. Most common occurrence of a erroneous data point comes
from operators who approach the surface, and then pause during the approach and
attempt to make contact under extremely slow speeds, which while approaching
causes variations in the path toward the surface.

To correct the reported direction of a 1D Point, highlight the feature by left
clicking on it, then right-click to bring up the feature menu, as shown in the figure
on the next page. Select [Point Direction], which will offer a sub-menu with all
six probing directions available. Choose the correct 1D Point direction and your
part inspection will update with the correct 1D Point.

Note: Once a feature has been referenced it can not be changed or edited. For
example, if a feature was used in the construction of a PCS , it will be locked from
changes. This is identified by the inclusion of a ¹ next to the feature number,
example " 12¹ ".
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1D Point Correction Sub-menu (both styles shown)

Using Auto-Direction with multi-point features such as circle, lines and planes
can also incorrectly report feature characteristics. This occurs when capturing data
points in an inconsistent method or by capturing data points at a high rate. As
previously mentioned, the calculation of the direction vector for the probe works
off the speed of the interface and should that rate of point capture be too high, the
changes in direction going toward, then backing off the data point will create a
poor direction vector.

Since touch probes can be effected by speed and our auto-direction tool is also
adversely effected by speed, we suggest the use of a smooth consistent approach
speed and rate when capturing data points.

2D Point

The 2D Point function is normally used in conjunction with a hard taper probe for
simple contact determination of the location of bores whose axes are parallel to
the PCS Z axis. It can also be used with hard ball stylus for single contact
determination of the location of bores whose axes are parallel to any PCS axis. In
these applications the 2D Point feature is referred to as the self-centering routine.

The 2D Point feature can also be used with hard
or electronic trigger ball stylus to create 2D
Bisector Point features in slots or a web for
Aligning purposes as shown in PCS Example #6.
All 2D Points are automatically projected into the
requested PCS base planes. The example shown
in figure, demonstrates the use of 2 - 2D Points
on the outside of the GeoWidget bisected to
obtain a 2D Point on the centerline of the body.2D Bisect Point Application
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Measured features that create a 2D point entity include the 4 Point Intersect, Slot /
Web and Oval Slot Macro Features.

To measure a 2D Point press the 2D Point key, < 5 > from the number pad.
Geomet Junior will prompt you for a PCS base plane the 2D Point will project
into, see figure below. Choose XY, YZ or ZX and begin your measurement.

2D Point Projection Plane Selector

Tolerancing of 2D Points is available in Cartesian, Polar or RFS Positional
Tolerance formats.

 Inside Radial / Outside Radial 2D Points

The IR (Inside Radial) and OR (Outside Radial) Point features allow 2D ball
radius compensated probing of cylindrical surfaces. The probe vector is
determined as a vector from the current PCS origin through the ball center of the
stylus. Adding one radius along this vector compensates inside Radial features.
Outside Radial subtracts one probe radius.

Outside Radial 2D Point

An IR / OR measurement is ideal for measuring extremely large radial surfaces
that only offer a small segment to capture data points on. Translate your PCS
origin to the center of the radial feature and capture radial points along the
surface.
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3D Points

The 3D Point feature reports the current PCS location of the center of the ball
stylus used in the measurement. It is useful in conjunction with a hard ball stylus
to establish a point on the axis of an ID cone. An example is to establish the
centerline of a turned part using two 3D Points, one at each end in the conical
shaped turned datum used by the head and tail stock made with a center drill.

To measure 3D Point Features, press the 3D Point key, < 5 > + <9>from the
number pad and begin your measurement.

Inside Radial / Outside Radial 3D Points

The IR (Inside Radial) and OR (Outside Radial) Point feature allow 3D ball
radius compensated probing of spherical surfaces. The probe vector is determined
as a vector from the current PCS origin through the ball center of the stylus.
Adding one radius along this vector compensates inside Radial features. Outside
Radial subtracts one probe radius.

These features are ideal for measuring extremely large spherical surfaces that only
offer a small segment to capture data points on. Translate your PCS origin to the
centroid of the feature and capture radial points along the surface.

Tolerancing of 3D Points is available in Cartesian, Polar or RFS Positional
Tolerance formats.
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Multi-Point Features in Geomet Junior

All multi-point features in Geomet Junior can be measured or constructed with
more than the default number of data points. Those defaults can be set in:

[System ⇒ System Options ⇒ Feature Characteristics]

The defaults set by Geomet Junior are only minimum suggestions to solve the
requested feature. To obtain additional information, such as form, always add
additional data points.

The table below shows the corresponding keystroke, icon and menu access for
each feature.

Feature Type Icon Keyboard Menu
Suggested

Minimum Data
Points

Line m [Measure ⇒ Line] 2

Circle z [Measure ⇒ Circle] 4

Plane b [Measure ⇒ Plane] 4

Cylinder c [Measure ⇒ Cylinder] 6

Cone n [Measure ⇒ Cone] 7

Sphere v [Measure ⇒ Sphere] 5

To request additional data points during the
inspection, press the <shift> key when selecting
your feature. For a circle use <shift + Z> and you
will be prompted to enter the data point count
required.

You can also increase the data point count by
pressing the feature key repeatedly. For example
if you are measuring a Circle and would like to
add two more data points, just press the <z> key
twice and the required count will increase. This can be done even when data
points have already been captured. To terminate and solve a feature before
capturing all data points, press the Terminate key, <F5>.



Chapter 4 – Feature Measurement

Helmel Engineering Products, Inc. Geomet Junior Training Handbook
www.helmel.com www.geomet-cmm-software.com

4-10

Line

Keyboard: m

Menu: Measure ⇒ Line

A line is the trail left by a point that moves in a constant direction. Lines are
infinitely long and have no width. A point somewhere along its length and a
direction characterizes a line. In Geomet Junior a line is reported as a pierce point
with a PCS base plane and two or three base plane projection angles. A 2D Line is
reported as the point where it intersects with a PCS axis. A 3D Line is reported as
the 2D Intersection with a PCS base plane.

The Line feature provides you with the means to measure multi-point 2D Lines.
2D lines are projected into a PCS base plane and report the angular deviation in
the current PCS base plane and a 1D pierce value of a PCS base axes, see figure
below. The line feature is multi-point consisting of 2 - 32767 data points.

Line projected into the PCS

Measure a Line

When starting the line tool <m>, you will be presented with a direction selector
dialog if Auto-Direction is turned off. The direction selection allows you to
choose the probing direction suited for the line to be measured.

Direction Selector Projection Plane Pierce Axis

After you select the probing direction, Geomet Junior will prompt you to
"Measure an -X Line", for example. Should Auto-Direction be turned on, Geomet
Junior will display "Measure a Auto-Line". Proceed to capture the required
number of data points.
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The determination of the PCS base plane is supplied by the operator after the
capturing of the data points. Depending on the angle of the line, Geomet Junior
will prompt for the selection of a PCS axis to report. Geomet Junior uses an angle
of ± 10° between the line normal to a PCS axis to determine if the operator should
be prompted to select the pierce axis.

For example, if a line being measured crosses the PCS X axis at 1.000" and has a
reported angle of 85°, the operator will not be prompted to select a PCS axis.
Should the same line have a reported angle of 75°, then Geomet Junior would
prompt the operator to select the pierce axis showing the solutions of both values
as shown in Pierce Axis figure on the previous page.

After completing the first measured line, Geomet Junior auto-cycles preparing to
measure another line. Note: after the first measure line is completed, Geomet
Junior will not prompt you for a projection plane. It is assumed that you will
continue measuring lines in the original selected plane. Should you require a new
projection plane, press <Esc> and select the line tool again.

The direction of the line is determined by the direction of the data points, from the
first data point to the second. In our example, the order the data points were
captured created a reported angle of -90° whereas should the order have been
reversed, the reported angle would be +90°. NOTE: see Switching the Reported
Angle Directions below. This is important when applying a tolerance value to the
angular component.

During the capturing of the data points, should you want to change the requested
number of data points you can press the line key repeatedly and the count will
increase by one with every depress without losing data points already captured.

If you have already captured sufficient data points to satisfy the line press <f5>,
Terminate, to solve the line without having to capture the remaining prompted
data points.

Tolerancing of Lines is available in Cartesian / Linear format.
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Switching of the Reported Pierce Axis

To switch the reported pierce axis of an already measured or
constructed line, highlight the line in the report area and right-
click. A sub menu will appear where you can choose [Switch PCS
Pierce Axis]. The option is available only when the line has not
been used as a PCS component and does not have a reference lock
attached to it.

Switching the Reported Angle Directions

As mentioned previously, the order the data points were taken in
will configure which angle will be reported. If you want to switch
the supplement angle with the normal reported angle, there exists
an option flag that can be set.

To switch the angles, highlight the line feature in the report section by left
clicking on it. Once the feature is highlighted, right-click to bring up the sub-
menu. Choose [Switch Angles....]. The report will update and reflect the switch
has been applied. To change it back, toggle the switch again by selecting [Switch
Angles....] again.
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Circle

Keyboard: z

Menu: Measure ⇒ Circle

The Circle feature reports the center location and diameter or radius of bores and
bosses whose axes are parallel to a PCS axis. The circle feature will give
erroneous results on skewed bores and bosses. Circle center locations are
projected into a PCS base plane and are 2D in nature.

Circle projected into the PCS

To measure bores or bosses, press the Circle key < z > for the default number of
data points as set in System Options. Geomet Junior will then prompt you for the
type of feature being measured, ID, OD, IR or OR. If you have Auto Direction
enabled, this prompt will not appear.

Inside/Outside Selector Out-of-Form Warning

If you required additional data points, you can repeatedly press the Circle key
which increments the required number by one, or press < shift> + < Z > and you
will be prompted to enter the required number.

Geomet Junior performs a form validation on your captured data points. This
function is called the Multi-Point Error Limit and is controlled by a setting in
System Options. In the event your circle exceeds this limit, Geomet Junior will
prompt you to accept or re-measure the feature. If you elect < Re-Measure >, you
will be prompted to capture new data points for the same feature. Note: The



Chapter 4 – Feature Measurement

Helmel Engineering Products, Inc. Geomet Junior Training Handbook
www.helmel.com www.geomet-cmm-software.com

4-14

Multi-Point Error Limit test is only performed in the self-teach mode, not during a
part program run.

Data points used to calculate a circle if not spread around the circle can cause
erroneous results. In the table below, we will use a 3 point circle with one point
.00014" off the nominal value for a 1.00" radius. The results are calculated to
show the error that is part of the reported values.

Arc(Degrees) Center Error Radius Error
180 0.00014 0.00000
120 0.00028 0.00014
90 0.00048 0.00034
60 0.00104 0.00090
30 0.00409 0.00395
20 0.00914 0.00899
10 0.03549 0.03535
5 0.12823 0.12810

Circle Deviations

Tolerancing of Circles is available in Cartesian, Polar or RFS, MMC and LMC
Positional Tolerance formats.

Switching between Radius and Diameter

Changing the reported characteristics of a previously
measured or constructed feature can be done directly on
the report. Select the circle feature in the report area and
right click to activate the feature sub menu. From the
available commands select [Switch Dia. / Rad.].
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Plane

Keyboard: b

Menu: Measure ⇒ Plane

Planes have locations, attitudes and directions. The location of a plane is defined
as the point at which it is pierced by a PCS axis. The attitude of a plane is defined
by the projection angle AX/Y, AY/Z and AZ/X of the plane normal in each of the
three PCS base planes, with range values from 0° to ± 180°.

Plane represented in the current PCS

The Plane feature may be used to measure non-skewed planes. The printed pierce
point of a measured plane is determined by the PCS axis that is most parallel to
the normal of the measured plane. Planes which are essentially parallel to PCS
base planes have only two attitude angles which are meaningful, the third is
printed in lower case, as for example "ax/y" to indicate its reduced significance.

AX/Y Projection AY/Z Projection AZ/X Projection

The vector normal defines the direction of a plane. The first figure above shows a
plane with its projection into each PCS base plane. The normal, when projected
into each PCS base plane provides the attitude in angles, see example above.
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Probe Direction Selector Out-of-Form Warning

To measure Planes press the Plane key <b> for the default number of hits as
established in System Options, or < shift> + < B > for a multi-point plane. If you
required additional data points even during point capture, you can repeatedly
press the Plane key which increments the required number by one. If auto-
direction is not enabled, you will be prompted to enter the probing direction.
Upon completion of gathering your required number of data points, Geomet
Junior will test the form error of the newly calculated plane. If the form error
exceeds the default setting, you will be prompted to < Accept > or < Re-Measure
> the plane.
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Pierce Point Reporting

It is important that your PCS be established close to the desired location where the
distance should be taken. As shown in figure below, should the PCS be outside
the effective location the distance is expected, the reported result will not
represent the actual distance.

Referring to figure below, we have two established Part Coordinate Systems. PCS
1, established on the base of the 2.000" gage block. PCS 2 is located 4.000"
inches in the X direction from the right side of the gage block.

Two planes were measured, one representing the lower base and one on top of the
gage block, The lower base plane was used to establish the XY PCS Base Plane
for both PCS 1 and 2. The top plane had an AZ/X of 89.9943° and the AY/Z was
90.0000°. The intersection of the pierce point with the PCS1 Z-Axis, d1, is
reported at 1.9999". The reported pierce point on the Z-axis of PCS2, d2 is
1.9995". By not having PCS localized to the actual measured surfaces we
introduced 0.0004", d3, error!
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Sphere

Keyboard: v

Menu: Measure ⇒ Sphere

A sphere is the trail left by a point traveling in every conceivable direction at a
constant distance from another point called its center. A sphere is also the surface
generated by a rotating circle about a coplanar axis through its center. The sphere
is characterized by its size as a Radius or Diameter and a three dimensional center
location.

Inside/Outside Selector Out-of-Form Warning

To measure a sphere, press the < v > key for the default number of data points as
established in System Options, or < shift > + < V > for a multi-point sphere.

If auto-direction is not enabled, Geomet Junior will prompt you for the
characteristic of the sphere, ID, OD, IR or OR. After the data points have been
captured, Geomet Junior will test the form error and if exceed, will prompt you to
< Accept > or < Re-Meas >.

Tolerancing of Spheres is available in Cartesian / Linear format.

Switching between Radius and Diameter

Changing the reported characteristics of a previously
measured or constructed feature can be done directly on
the report. Select the sphere feature in the report area and
right click to activate the feature sub menu. From the
available commands select [Switch Dia. / Rad.].
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Cylinder

Keyboard: c, Shift + C

Menu: Measure ⇒ Cylinder

A cylinder is the trail left by a line, which revolves around and at a constant
distance away from a parallel line called its axis. A cylinder is characterized by a
point and direction of its axis and by its diameter or radius.

Cylinder Projection in the current PCS

The cylinder feature determines the size, PCS pierce point and attitude of the axis
of bores and shafts. The attitude of a cylinder axis is expressed like the attitude of
the normal of a plane, using the characteristic identifiers AX/Y, AY/Z and AZ/X.
These angles can vary between 0° and ± 180°. The axis of a cylinder has a
direction as well as an attitude: its direction is from a group of points measured
near its bottom toward a group of points measured near its top.

The reporting of the position in the PCS is the point where the axis of the cylinder
intersects a PCS base plane, called its pierce point. Geomet Junior determines
which PCS base plane to report by determining which PCS base plane the axis of
the cylinder is most normal to.

Inside/Outside Selector Out-of-Form Warning

To measure bores or bosses press the Cylinder key <c> for the default number of
data points as established in System Options, or <shift> + < C > for a multi-point
cylinder.
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If auto-direction is not enabled, Geomet Junior will prompt you for the type of
cylinder, ID, OD IR or OR.

Collect the first 3 data points at or near the "bottom" of the bore or boss. Collect
the last 3 data points at or near the "top". Should you require more than 6 data
points, the data points captured after first 3 and before the last 3 can be captured
anywhere on the bore or boss.

Collect the First 3 Data Points Collect the Last 3 Data Points

The order in which these two 3 point end groups are collected determines the
direction of the axis of the cylinder. After the data points have been captured,
Geomet Junior will test the form error and if exceeded, will prompt you to <
Accept > or < Re-Meas >.

The order in which these two 3 point end groups are collected determines the
direction of the axis of the cylinder. After the data points have been captured,
Geomet Junior will test the form error and if exceeded, will prompt you to <
Accept > or < Re-Meas >.

Tolerancing of Cylinders is available in Cartesian, Polar or RFS, MMC and LMC
Positional Tolerance formats.

Switching between Radius and Diameter

Changing the reported characteristics of a previously
measured or constructed feature can be done directly on
the report. Select the cylinder feature in the report area
and right click to activate the feature sub menu. From the
available commands select [Switch Dia. / Rad.].
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Cone

Keyboard: n, Shift + N

Menu: Measure ⇒ Cone

A cone is the trail left by a line which rotates about another non-parallel and non-
perpendicular, intersecting line called its axis. The intersection of the two lines is
called the apex. The cone is characterized by a point on its axis (PCS base plane
pierce point), the direction of its axis, its apex, its included angle and its radius at
the pierce point.

The attitude of a cone axis is expressed like the attitude of the normal of a plane,
using the characteristic identifiers AX/Y, AY/Z and AZ/X. These angles can vary
between 0° and ± 180°. The axis of a cone has a direction as well as an attitude:
its direction is from a group of points measured near its bottom toward a group of
points measured near its top.

To measure a Cone, press the < n > key for the default number of data points as
established in System Options, or < shift > + < N > for a multi-point cone. If auto-
direction is not enabled, Geomet Junior will prompt you for the type of cone as
either a ID, OD IR or OR.

Inside/Outside Selector Out-of-Form Warning

Collect the first 3 data points at or near the "bottom" of the cone. Collect the last 3
data points at or near the "top". Should you require more than 7 data points, the
data points captured after first 3 and before the last 3 can be captured anywhere
on the cone.

Collect the First 3 Data Points Collect the Last 3 Data Points

The axis of a cone has a direction as well as an attitude: its direction is from the
group of points measured near its bottom toward the group of points measured
near its top. After the data points have been captured, Geomet Junior will test the
form error and if exceeded, will prompt you to < Accept > or < Re-Meas >.
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Switching between Radius and Diameter

Changing the reported characteristics of a
previously measured or constructed feature can be
done directly on the report. Select the cone feature
in the report area and right click to activate the
feature sub menu. From the available commands
select [Switch Dia. / Rad.].

Cone Offset

The Cone Offset command produces a reported
diameter at a specified distance from the PCS
Base Plane. For example, what would the
diameter on the cone at –0.250” below the PCS? To obtain the value, highlight the
cone in the report and right click to activate the sub menu, choose [Cone Offset].

Cone Offset Setup Tool

Enter –0.250 in the Cone Offset Setup Tool and select <Ok>. The Offset Tool
will provide a range of available values. This starts at the apex of the cone. The
reported cone diameter is the solution of a parallel plane intersecting the cone at
the specified offset.

Reported results from a Cone Offset
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Cone Diameter

Another very powerful feature of the available
Cone analysis tools is the ability to locate the
height off the PCS Base Plane that a specified
diameter exists at. For example if measuring a
cone that defines the seating surface of a valve
and the dimensional requirement is to measure the
height where the cone has a diameter of 3.500”.
First we measure the cone the right click on the
cone to activate the sub menu. From the
commands, choose [Cone Diameter]. Enter 3.500
in the Cone Diameter Setup Tool and press <Ok>.

Cone Diameter Setup Tool

In the graphics, a circle appears at the specified height. The reported value will be
shown in the report.

Reported results from a Cone Offset

In this example the measured height is called the Effective Depth and has a value
of 1.1792”.
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Cone Drop Ball Test

The Cone Drop Ball Test is used to place a test
ball in a cone and calculate the diameter and
position where the ball intersects with the cone.

To use this test, right click on the cone in the
report and choose [Cone Drop Test] from the sub
menu.

Enter the radius of the ball that will be dropped
into the open end of the cone.

Cone Drop Test Setup Tool

By default the results of the calculation is the XYZ position of the center point of
the ball and its diameter on the cone where it makes contact. The reported
position can be switched to the top of the ball by right clicking on the Drop Test
record and from the sub menu choose [Switch Top <-> Center Reporting].

Cone Drop Test Sub Menu Ball Drop Results
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Ball Bar Macro

One method to accurately evaluate axis to axis relationships is found in the
B89.4.1, Methods for Performance Evaluation of Coordinate Measuring Machines
published by ASME International. This Standard establishes requirements and
methods for specifying and testing the performance of coordinate measuring
machines (CMMs) having three linear axes perpendicular to each other and up to
one rotary axis positioned arbitrarily with respect to these linear axes. In addition
to clarifying the performance evaluation of CMMs, this Standard seeks to
facilitate performance comparisons among machines by unifying terminology,
general machine classification, and the treatment of environmental effects.

The Ball Bar consists of a temperature-stabilized bar with two high precision
spheres mounted at each end, see figures below. The length between the spheres is
not necessary to be known. The Ball Bar is positioned within the measuring area
of the CMM in 28 different positions as described in ASME B89.4.1.

T assis in the gathering of the distance between spheres, the Ball Bar Marco is
used.

Using the Ball Bar Macro

Activate the macro using the drop down menus:

Measure ⇒ Ball Bat Macro

You will be prompted the required number of data points and the sphere to
capture them on. The reported value is the distance between the Spheres.

For a more detailed use of the Ball Bar routine, visit the Geomet web site:

http://www.geomet-cmm-software.com/tn-002.htm
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Understanding Coordinate Systems
Supported Geomet Junior Coordinate Systems:

• MCS - Machine Coordinate System
• PCS - Part Coordinate System
• ICS - Interim Coordinate System

PCS Differences between Geomet Junior and Geomet Junior Plus

Geomet Junior provides access to one PCS that can be redefined during the
inspection process. Geomet Junior Plus has expanded PCS capabilities offering
multiple PCS support. During the inspection process you can establish several
PCSs as required to perform the inspection. Since Geomet Junior is a on-demand
inspection tool and does not cycle inspection programs, there are limits placed
upon it.

MCS - Machine Coordinate System

The MCS is the XYZ position on the CMM with respect to the Home Position.
The MCS axes are mutually parallel with the movement of the CMM.

Most manual CMMs do not have a home position; therefore the home position is
the location of the CMM at the point of starting the system. Some manual CMMs
do offer a home position that requires the operator to manually move the CMM
over reference marks one axis at a time.

On a Direct Computer Control (DCC) system, the start-up procedure requires that
you "Home" the CMM. This process will drive the CMM one axis at a time, to the
designated home location and establish a repeatable XYZ zero point.

An MCS is therefore not a valid coordinate system to obtain reliable measured
values for your part inspection, unless the part is carefully aligned with the
machine axes.
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PCS - Part Coordinate System

The PCS is the foundation that establishes the Orientation, Alignment and Origin
of your part inspection. PCSs are simply the frames of reference in which part
feature locations are defined.

Traditional drawings were made using 2D projections to represent 3D objects.
Each 2D view shared a common reference point and common axis of alignment
allowing the building of 3D features. In fact, a 3D dimensional PCS is implied.

Today, it is common to create machined parts using a 3D model created by many
popular CAD tools. These models may contain all necessary information for the
machinist to create the part and for the inspector to validate the final production.
However, the PCS is still implied using the same procedures as if measured from
a 2D drawing.

The established method for creating and using a datum frame reference can be
found in the ASME Y14.5M - Dimensioning and Tolerancing manual. Geomet
Junior uses these accepted practices in the application of PCS. To better
understand this let us consider the multi-projection part shown below:

In order to measure this part on a coordinate measuring machine we shall need to
contact it with probes on all sides. In planning to do this it is helpful to visualize
the 3D coordinate system of the part. Let us do this by making a perspective
drawing from one possible direction and then overlaying a 3D PCS. The figure
below is one possible view of the 3D dimensional PCS applied to the GeoWidget.
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The way in which the PCS is overlaid on the part is determined by the datums
defined in the drawing. Notice that each datum can be represented by a standard
measured feature; The datum -A- is the ZX plane, datum - B - is the YZ plane and
datum - C - is the XY plane. The XY, YZ and ZX planes are orthogonal to one
another.

The important point to remember is that the two dimensional drawings we deal
with represent three dimensional concepts, and in order to effectively measure a
3D part with a coordinate measuring machine we must "see" the 3D PCS
associated with the part. This is made easier by looking at the actual part,
referring to the drawing and making a habit of imagining the datums as we view
the part.

PCS Base Planes

PCS Base Planes are the extracted XY, YZ or ZX datum planes of an established
Part Coordinate System. When extracted through the Recall Component tool, they
become constructed planes and are given a feature number in the inspection
report.

PCS versus MCS

Since features of machine parts are defined in terms of their datum references, we
must create Part Coordinate Systems reflecting those datums before the features
can be measured. Since coordinate measuring machines have their own coordinate
system, namely a system of mutually orthogonal axes of motion referred to as the
Machine Coordinate System (MCS), the first problem we face is to create the PCS
within the MCS. This is not trivial.

One way to create a PCS within a coordinate measuring machine is to make the
PCS coincide with the MCS. The procedure consists of physically aligning the
datum surfaces of the part parallel to the axes of motion of the machine and
setting the X, Y and Z readout display to the datum of the part. Once the MCS
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and the PCS have been made to coincide, all dimensions found on the display of
the coordinate measuring machine are also feature locations on the part.

Making the PCS and MCS coincide physically can be extremely time consuming,
and sometimes impossible. We can eliminate the problem by using Geomet Junior
to create and store a skewed PCS. Once a PCS has been established, the computer
converts raw data collected in the machine coordinates into measurement results
in part coordinates. Once the PCS has been established, you will see a part
coordinate system with X, Y and Z axes nested inside a machine coordinate
system with its own X, Y and Z axes.

The MCS and the PCS are totally skewed relative to each other. With the help of
Geomet Junior any point in the MCS can be expressed in the PCS.

As Geomet Junior can manage the link between an MCS and a totally skewed
PCS we no longer need to physically align the parts to the machine. BUT...we
need to create the skewed PCS in Geomet Junior before it can manage the link.
The job of creating the PCS will be simple once we understand a few fundamental
principles.

ICS - Interim Coordinate System

The ICS is a coordinate system that has not been completed to the status of a PCS.
For example, when Geomet Junior begins a part inspection, the only coordinate
system available is the MCS. Should the part to be inspected have the orient
applied to it, Geomet Junior creates an ICS based on the orient vector data and
brings forward the alignment and origin data from the MCS.

During the inspection process, reported results on features are hidden until the
PCS is completed. Only then will the reported data be meaningful.
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Part Coordinate System Setup Guide

In order to ensure that a complete PCS has been established Geomet Junior
provides a visual PCS Setup Guide to remind you of the missing components of
the current PCS under construction. In the sample below, we show the setup guide
with all axis and origins still requiring definition.

When you establish one of the PCS components, such as the Z primary axis
derived from the Orient function on a measured or recalled qualifying feature, the
setup guide will reflect the completion by "signing- off" that component with a
series of "*******" as shown above. During the building of a PCS, Geomet
Junior maintains an Interim Coordinate System, ICS, which contains the resolved
transformations and carries forward the missing components from the MCS.

During the inspection process, additional PCSs may be required. Should you want
to create another PCS by starting with the Orient function, the PCS Setup Guide
will reappear and further results will be suppressed until the ICS is resolved into a
completed PCS. The setup guide will not reappear with basic transformations on a
current, completed PCS that results in a new PCS. These commands are:

• Alignment
• Origin
• Translate
• Rotate

Each of these commands when applied to a complete PCS results in the creation
of a new PCS.

It should be noted that as long as a PCS is under construction, no results are
displayed with each measured feature. When the PCS is completed, the PCS
Guide Box will disappear from view and the suppression of results is removed.
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Coordinate System Commands

ICS ⇒ PCS, Interim Coordinate System

The ICS is a coordinate system that has not been completed to the status of a PCS.
For example, when Geomet Junior begins a part inspection, the only coordinate
system available is the MCS. Should the part to be inspected have the orient
applied to it, Geomet Junior creates an ICS based on the orient vector data and
brings forward the alignment and origin data from the MCS. During the
inspection process, reported results on features are hidden until the PCS is
completed. Only then will the reported data be meaningful.

The ICS ⇒ PCS Command is activated by:

Keyboard: shift + “

Menu: PCS ⇒ “ICS ⇒ PCS"

The ICS ⇒ PCS routine converts the status of an interim coordinate system from
interim to complete. The effect of this routine is to permit the user to obtain
printed results from what would normally be suppressed data.

For example ICS ⇒ PCS might be used when establishing the first coordinate
system on a sample part such as shown in figure 1. In this example, we have the
GeoWidget laying on the surface plate of the CMM with the OD cylinder pointing
in the -X direction. The required dimension to inspect is the distance between the
two bores as shown in figure 1.

figure 1
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Step 1

Our first operation would be to measure the circle designated A/4 using an ID
Circle, see figure 2.

figure 2

Step 2

Select Origin, Geomet Junior will prompt you to establish the X and Y origins,
which you answer <Yes>, to both. This will create an ICS with the X and Y
origin in the center of A/4.

Step 3

Select the ICS ⇒ PCS command. This will bring forward the Orient, Alignment
and the Z origin from the ICS. A completed part coordinate system will be
established as shown in figure 3.

figure 3

Step 4

Switch Geomet Junior to Polar reporting mode if it is not already there. Press the
key <e> to toggle between Cartesian and Polar modes.

Step 5

Measure circle B/4 using the circle command. The reported values will be
straight-line values satisfying the requirements as shown in figure 1.
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Orient

Keyboard: j

Menu: PCS ⇒ Orient

Orient establishes the direction of the primary PCS axis, with the selection of X,
Y or Z determined by the MCS X, Y or Z-axis to which the directed feature axis
is most parallel. Orient acts on the last measured or recalled 3D directed feature or
pair of non-directional features, which could serve to create a 3D, directed
feature. Orient sees through transparent operations such as other PCS formation
commands, distance and angles, etc. Orient will be disabled for feature(s) that are
not validated as having the required components to establish a primary datum.

The Orient command destroys the axis and origin references of the previous PCS
and, if not already visible, invokes the PCS Setup Guide. For proper function, the
Orient must be followed by the Align command with one exception, after
performing the orient command; you can establish the origin on the characteristics
of the feature. An example might be the measuring of an XY plane, which is used
to establish the primary datum through the orient command along the Z-axis.
Once the orient has been completed, you can establish the Z origin on that plane.
Another example might be establishing the primary axis through two spheres.

When the Orient command is activated, Geomet Junior will look at the last feature
in the inspection report to determine whether it has the necessary information to
form the Primary datum. Should Geomet Junior determine that the last feature
requires a second feature to solve for a primary datum, then it will continue to
look back in the inspection report until the next feature is found. If the validation
tests fail, Geomet Junior will then inform the operator that the orient command
has failed and will abort the operation.
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Align

Keyboard: k

Menu: PCS ⇒ Align

Align establishes the directions of the secondary and tertiary PCS axes, with the
selection of X, Y and Z determined by the MCS X, Y or Z axis to which the
directed feature axis is most parallel. Align acts on the last measured or recalled
3D or 2D directed feature or pair of non-directed features which could serve to
create a 2D or a 3D directed feature. For example, a pair of 1D co-directional
points, pairs of coplanar 2D points, or pairs of 3D points. The Align command
will see through transparent operations such as other PCS formation commands,
distance, angle commands, etc. Geomet Junior will validate the last feature(s) to
determine whether they are capable of providing a secondary datum.

Align, when executed in an ICS directly after the orient has been established
makes an automatic choice for the alignment axis. For example, if the orient
command resulted in establishing the Z-axis, then the Align command will rotate
about the Z to establish the secondary datum.

When the Align command is executed in an established PCS, the resulting
operation creates a new PCS by aligning to the requested feature. The Align
command will determine the alignment axis when a pair of co-directional 1D
points or coplanar 2D features is used. When using a pair of 3D features or a 3D
axial feature, Geomet Junior will prompt for the PCS base plane to align in.
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Origin

Keyboard: l (lower case L)

Menu: PCS ⇒ Origin

The Origin command builds the tertiary datum on the location of the last
measured or recalled feature. In the case of features with 1D locations such as 1D
points and planes the origin is established for the reported direction of the feature.

Using a +X 1D Point, the Origin command will set the reported position along the
X-axis as the new X-axis origin leaving Y and Z untouched. For a –Z Plane, the
Z-axis Origin is set where the plane crosses the existing Z-axis.

For 2D and 3D features, the Origin command will prompt you to choose which
axis to set. On a 2D XY Circle, you may elect to set the X-axis and not the Y-
axis.
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Rotate

Keyboard: shift + :

Menu: PCS ⇒ Rotate

Rotate permits an existing PCS to be rotated in space about one of its own axes. A
PCS can only be rotated about one axis at a time. Compound rotations must be
done in two or more successive steps. It is important to note the following rotation
conventions:

Rotate about the X-Axis - a positive angle produces a counter-clockwise rotation
when looking in the -X direction.

Rotate about the Y-Axis - a positive angle produces a counter-clockwise rotation
when looking in the +Y direction.

Rotate about the Z-Axis - a positive angle produces a counter-clockwise rotation
when looking in the -Z direction.

In the Rotate PCS Dialog, see figure below, we show a request to rotate the
current PCS 25° around the X-axis. To ensure only one axis of rotation, any entry
in Y or Z, would result in clearing the entered value in X. In the examples shown
below, a rotation is applied to each axis with its corresponding change in
relationship to the sample part.

Note that the sense of directional measurements made by specifying a direction
using directional keys; +X, -Y, etc. rotates with a PCS rotation. After rotating a
PCS whose axes are essentially aligned with the MCS axes by 90º about the PCS
Y axis, a +X measurement is understood to be directed upward instead of to the
right, since that is now the direction of the +X axis.
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Edit an Existing Rotation Value

A Rotate PCS feature once applied creates a new Part Coordinate System. You
may edit the existing rotation value when there are features using the rotated PCS,
but a warning is provided to rebuild all coordinate systems by running the
program from the beginning.

To edit the existing rotation feature, highlight that feature and bring up the right-
click sub menu. From the sub menu, select Edit Rotate Values. NOTE: The ability
to edit a translated feature is only available when the translate feature has absolute
entered values, not values derived from the last feature option.

Enter the new rotate value in the space provided and press the <Ok> button.
Geomet Junior will display a warning that the features will no longer have valid
positional data after the edit of the rotation values is completed. At this time, save
the part inspection file and run the file to rebuild the Part Coordinate Changes.
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Translate

Keyboard: ;

Menu: PCS ⇒ Translate

Translate permits an existing PCS origin to be shifted by nominal amounts in all
three directions. Translation creates a new complete PCS whose axes are parallel
to those of the preceding PCS but shifted by the input values.

To perform a Translate, activate the Translate tool using the keyboard “;” or [PCS
⇒ Translate] from the drop down menus. Geomet Junior offers two methods to
perform a PCS Origin Translation. The first method uses XYZ incremental values
to translate the current origin, which are entered by the operator. To use this
method, place a bullet next to the "Enter Values" entry in the Translation Source
group box.

To translate absolute values, enter the required absolute values in the X, Y and Z
edit controls provided. You can translate 1, 2 or 3 axis with one translate
command. Upon completion, a new PCS is established using the next available
PCS ID number.

In the “Use Last Feature” method, we can obtain a feature specific value such as
the radius of the previously measured circle. Qualifying features include Circle,
Cylinder, Cone and Sphere. When you place a bullet next to "Use Last Feature",
Geomet Junior will show the radius value in the Translation Source box under
"Use Last Feature".

The ( - ) and ( + ) column will become active next to the data fields. You can then
check the appropriate directions you wish to translate in. Should you not want to
translate in any axis, leave the check marks unchecked.

An example would be when the origin is called out on a tangent point of a circle.
After you have established the Orient and Align Axis, measure the circle and
place the origin in the center. Then perform a PCS Translate using the last feature
option. Select the appropriate direction under the ( - ) and ( + ) columns. After
accepting the translation, the new origin will be on the tangent point of the circle.

Both methods will create a new PCS. To summarize the methods, when "Enter
Values" is selected, the values entered by the operator are considered absolute and
will carry forward with each successive inspection run. Selecting "Use Last
Feature" the translation values will recalculate with each inspection run and are
considered dynamic to the current inspection run.
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Edit an Existing Translation Value

A Translate feature once applied creates a new Part Coordinate System. You may
edit the existing translation values when there are features using the translated
PCS, but a warning is provided to rebuild all coordinate systems by running the
program from the beginning.

To edit the existing translation feature, highlight that feature and bring up the
right-click sub menu. NOTE: The ability to edit a translated feature is only
available when the translate feature has absolute entered values, not values
derived from the last feature option.

Enter the new translation values in the space provided and press the <Ok> button.
Geomet Junior will display a warning that the features will no longer have valid
positional data after the editing of translation values has been completed. At this
time, save the part inspection file and run the file to rebuild the Part Coordinate
Changes.
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One-Step PCS Generator

The One-Step PCS function is a macro to assist in establishing a basic PCS. It
generates a PCS from a plane, line and point commonly used to build a PCS. The
Plane is created from 3 data points. The Line is build from 2 data points and the
final Point is a 1D directional point. The result is commonly known as a 3-2-1
coordinate system.

To activate the One-Step tool, select [PCS ⇒ One-Step PCS] from the main drop
down menus. The setup dialog will appear with the last known settings.

Through this setup dialog you will establish the probing directions for each
measured featured. By default it opens in the Orient mode which is the setting
used for the Plane. To move to the Align component, click the <Next > or
<Align> button. Similarly to move to the Origin click the <Next> or <Origin>
button.

Orient Probe Directions Align Probe Directions Origin Probe Directions

When you have chosen all directions, press the <Ok> button and Geomet Junior
will prompt you to: Capture Orient –Z Data Point (0/3).

When you have captured the three data points, the prompt will display the
requirements for the alignment: Capture Align +Y Data Points (0/2).

Upon completion of the two alignment data points Geomet Junior will prompt for
the final Origin Point: Capture Origin –X Point 1.

If you should capture an errant data point, you can remove that data point by
pressing the <f2> Abort Point tool.

When all six data points have been captured, Geomet Junior will calculate the
new Coordinate System.
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PCS Program Examples

Here you will find 10 Part Coordinate Examples to assist your learning of the
processes used for measuring features and applying them to the building of a Part
Coordinate System. On the Geomet web site, these examples can be downloaded
to view the end results on your system.

Try each example and compare your final results with that of our supplied
examples.

PCS Program Examples
#1, Basic Alignment
#2, Plane-Line-Point
#3, Quick PCS
#4, Plane-Circle-Circle
#5, Plane-Cylinder-Circle
#6, Plane-Bisect Points-Circle
#7, Cylinder-Circle-Point
#8, Plane-Intersect Lines-Bisect Points-Circle
#11, Translate
#12, Rotate

NOTE: Pcs Examples #9 and #10 are removed from the Geomet Junior manual as
they illustrate creating a PCS using Pivot Align and Offset Align which are
features unique to Geomet 101 and above.

For more information regarding advance PCS features, please review the Geomet
web site at:

http://www.geomet-cmm-software.com/KbIndex3.htm



Chapter 5 – Coordinate Systems

Helmel Engineering Products, Inc. Geomet Junior Training Handbook
www.helmel.com www.geomet-cmm-software.com

5-19

PCS Building Example #1: Basic Alignment

Most CMMs offer a machine coordinate system that is true to the working
surface. This allows the operator to establish simple, and fast, part coordinate
system by eliminating steps normally required to ensure accurate alignments. The
following example assumes the part orient in the Z axis is parallel to the Z axis of
the CMM and the cylinder of the Widget is pointing in the -X direction.

Step 1

Request a -X Point <4>, You will then be prompted to "Measure -X Point".
Capture points A-1 and A-2; refer to the figure above. Note: if your system is
active for auto-direction sensing then your prompt will display "Measure Auto-
Dir Point". See System Options for controlling Auto-Direction Sensing.

Step 2

Select Align <j>. Note: when you elect to perform an alignment without first
establishing the orient, Geomet Junior will assume the orient axis is parallel to the
machine coordinate system. For example, aligning in the XY plane will force the
Z-axis of the MCS to establish the Z-axis of the ICS.

Step 3

Select Origin <l>. This will establish the X origin as defined by the selected
direction of the -X Point features. Note: always perform the alignment prior to
origin, as the alignment will effect the probe compensation on features such as 1D
Points.

Step 4

Request a -Z Point <2>, You will then be prompted to "Measure -Z Point".
Capture point B-1.
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Step 5

Select Origin <l>. This will establish the Z origin and your PCS Setup Guide will
now reflect that only the Y origin is still required.

Step 6

Request a +Y Point <9>, You will then be prompted to "Measure +Y Point".
Capture point C-1.

Step 7

Select Origin <l>. This will establish the Y origin and complete the ICS to a full
part coordinate system. The PCS Setup Guide will disappear and you are now
ready to take feature measurements.

Summary

With a minimum of four data points and four command requests administered in
the proper sequence you have completed a full part coordinate system, see figure
above. This method of establishing a PCS is not meant to work with all
production parts, but it does work with parts that have a surface that is capable of
providing the orientation, or primary datum, and can lay flat on your CMM.
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PCS Building Example #2: Basic PCS Plane - Line - Point

In this exercise, we will create a basic part coordinate system utilizing a plane,
line and point for establishing the axes and origins. The following example
assumes the part is placed on your CMM where the cylinder of the Widget is
pointing in the -X direction.

Step 1

Request a -Z plane <b>, if auto-direction is not activated, you will be prompted
for the probing direction which you should select as -Z. You will then be
prompted to "Measure -Z Plane", (if auto-direction is active "Measure Auto-Dir
Plane"). Capture points A-1, A-2, A-3 and A-4 as shown in the figure above.

Step 2

Select Orient <j>. The orient command will create the primary datum on the axis
that is most normal to the machine coordinate system. For example, if the plane
used by orient was determined to be a XY plane then the normal will most closely
align with the Z-axis. In your PCS Setup Guide, the Z-Axis will be signed off.

Step 3

Select Origin <l>. This will establish the Z origin that is determined by the normal
direction of the -Z plane.

Step 4

Request a Line <m>, You will then be prompted to select the probing direction,
enter -X (if auto-direction is not active). The prompt will update to display
"Measure -X Line" (or "Measure Auto-Dir Line"). Capture points B-1 and B-2.
When the points have been captured, you will be asked which projection plane to
use, select XY. A secondary request may be made to determine the pierce axis,
select X, see Measured Features - Line for explanations.
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Step 5

Select Align <k>. Your ICS will update to include the secondary datum that is
derived from the XY line feature.

Step 6

Select Origin <l>. This will establish the X origin that is determined by the
reported direction of the XY Line.

Step 7

Request a +Y Point <9>, You will then be prompted to "Measure +Y Point".
Capture point C-1.

Step 8

Select Origin <l>. This will establish the Y origin and complete the ICS to a full
part coordinate system. The PCS Setup Guide will disappear and you are now
ready to take feature measurements.

Summary

The Plane-Line-Point combinations of features are commonly used for most
machined parts to set the part coordinate system. It is important to remember that
the features in these exercises are utilizing minimum data points to achieve a
complete PCS. There are several factors that can negatively effect the quality of
your data points. These include probing speed and distance between data points
just to name two.

In the case of the alignment, we used two points to calculate the line. The
repeatability of the electronic trigger probe can be as much as .00014" with a
standard 20 mm extension. If the two points for the line were taken 0.500" apart,
the possibility exists of .00028" error per inch, when applied to the PCS effects all
features being measured. It is therefore important that you select the most stable
features to establish your PCS and balance the number of data points to help
reduce inherent CMM and operator errors. When possible, use more data points to
help define the feature, especially when these features are used for establishing
datum features.
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PCS Building Example #3: Quick PCS

In this exercise, you will utilize Geomet Junior’s automatic part coordinate system
tool, known as the Quick PCS. Quick PCS requires that you have auto-direction
capabilities and that it is active through [System Options⇒Enhanced Features].

The premise of Quick PCS is to perform the basic Plane and 3 - 1D Point setup to
create a PCS without the operator commanding any feature requests. When you
start Geomet Junior and establish the working stylus, Geomet Junior is waiting for
a data point. If it acknowledges an incoming data point and is not currently setup
for a feature, it assumes you are invoking the Quick PCS option.

Step 1

Using the datum targets as shown in the figure above, gather data points A-1
through A-4. Geomet Junior will automatically establish a plane, orient and origin
after the forth point has been captured.

Step 2

Gather data points B-1 and B-2 making sure you follow the rules on probing 1D
points using auto-direction, see Measured Features - Points. Once these two
points are captured, Geomet Junior will establish the alignment and origin based
on the point directions.

Should the points be captured in such a way as to misidentify the direction, the
Quick PCS tool will abort the auto sequence and return you to normal inspections.
If this occurs, correct the point direction (see Measured Features - Points) and
continue with the setup as described in exercise 2, steps 5 - 8.

Step 3

Capture the final data point, C-1 and Geomet Junior will complete the final origin
and establish PCS 1.
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Summary

With the Quick PCS feature of Geomet Junior, you were not required to press any
feature key or in any other way instruct Geomet Junior of the next feature or
action.
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PCS Building Example #4: Plane - Circle - Circle

In this exercise, we will create a basic part coordinate system utilizing a plane and
two circles for establishing the axes and origins. The following example assumes
the part is placed on your CMM where the cylinder of the Widget is pointing in
the -X direction.

Step 1

Request a -Z plane <b>, if auto-direction is not activated, you will be prompted
for the probing direction which you should select as -Z. You will then be
prompted to "Measure -Z Plane", (if auto-direction is active "Measure Auto-Dir
Plane"). Capture points A-1, A-2, A-3 and A-4 as shown in the figure above.

Step 2

Select Orient <j>. The orient command will create the primary datum on the axis
that is most normal to the machine coordinate system. For example, if the plane
used by orient was determined to be a XY plane then the normal will most closely
align with the Z-axis. In your PCS Setup Guide, the Z-Axis will be signed off.

Step 3

Select Origin <l>. This will establish the Z origin that is determined by the normal
direction of the -Z plane.

Step 4

Select Circle <z>, if auto-direction is not activated, you will be prompted for the
Circle types, ID OD IR OR, choose ID. Capture the four data points identified as
B-ID/4. Continue with the data points for the next circle, C-ID/4.
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Step 5

Select Align <k>. Your ICS will update to include the secondary datum that is
derived from the two XY circles. The alignment takes place through the reported
XY position of the circles, which are projected, into the orient plane.

Step 6

Select Origin <l>. Circles, which are 2D, provide two directions when
establishing an origin. In our example, the circle can be used for the X and/or the
Y directions. The origin command will prompt you whether to use the X and then
the Y. For our example you should answer Yes to both requests. Upon
completion, you will have established PCS 1.

Summary

In this exercise, we utilized two coplanar XY features for the alignment and
subsequent origin. As with many feature characteristics, the circles could have
been replaced with any feature that reports a 2D solution. These include 2D
points, cylinder and cone pierce points, etc. Through the proper selection of
features, you can establish a part coordinate on nearly any type of manufactured
part.
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PCS Building Example #5: Plane - Cylinder - Circle

In this exercise, we will create a part coordinate system utilizing a plane for the
orient and origin, a cylinder for the alignment followed by a circle for the last
components of the origin. The following example assumes the part is placed on
your CMM where the cylinder of the Widget is pointing in the -X direction.

Step 1

Request a -Z plane <b>, if auto-direction is not activated, you will be prompted
for the probing direction which you should select as -Z. You will then be
prompted to "Measure -Z Plane", (if auto-direction is active "Measure Auto-Dir
Plane"). Capture points A-1, A-2, A-3 and A-4 as shown in the figure above.

Step 2

Select Orient <j>. The orient command will create the primary datum on the axis
that is most normal to the machine coordinate system. In your PCS Setup Guide,
the Z-Axis will be signed off.

Step 3

Select Origin <l>. This will establish the Z origin that is determined by the normal
direction of the -Z plane.

Step 4

Select Cylinder <c>, if auto-direction is not activated, you will be prompted for
the cylinder type: ID OD IR OR, choose OD. Capture the six data points
identified as B-OD/6.
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Step 5

Select Align <k>. A cylinder offers the possibility of more than one alignment
solution. In our example, you have solved the Z-axis orient by utilizing the
previous plane; therefore you are attempting to align the remaining axis, or XY.
Select the XY button from the Select Axis dialog that is displayed during the
Alignment process.

Your ICS will now update to include the secondary datum that is derived from the
longitudinal axis of the cylinder. In this example, the cylinder was reported as
piercing the YZ ICS base plane, therefore the normal to that plane is X with a
direction of -X. The PCS Setup Guide will update to reflect the XY Axis have
been solved.

Step 6

Select Circle, if auto-direction is not activated, you will be prompted for the
Circle type: ID OD IR OR, choose ID. Capture the four data points identified as
C-ID/4.

Step 7

Select Origin. The Circle, which is 2D, provides two directions when establishing
an origin. In our example, the circle can be used for the X and/or the Y direction.
The origin command will prompt you whether to use the X and then the Y. For
our example you should answer Yes to both requests. Upon completion, you will
have established PCS 1.

Summary

There are times when you are required to utilize more than one 3D feature to
solve for the part coordinate system. In this example we used a 3D feature, a
cylinder, from which the alignment is derived, therefore you are prompted to
solve which part coordinate system component to solve.

From this example you should note that the data point spread on the cylinder is
approximately 1.25"in the X-axis and the width of the part is 4.50". This can be a
cause of concern as it is poor inspection practice to have your data point spread
ratio to the width of the part less than 50%, in this case only 28%. The possibility
of skewing your part coordinate system increases dramatically as your ratio is
reduced.

However, conditions do arise that do not allow for proper setup and as the
inspector, you are challenged to determine the best data point spreads with the
features available that will produce a sound part coordinate system.
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PCS Building Example #6: Plane - Bisect Points - Circle

In this exercise, we will create a part coordinate system utilizing a plane for the
orient and origin, two 2D points from which we will obtain a constructed 2D
point through the bisect command then followed by a circle for alignment and
origin. The following example assumes the part is placed on your CMM where
the cylinder of the Widget is pointing in the -X direction.

Step 1

Request a -Z plane <b>, if auto-direction is not activated, you will be asked for
the probing direction which you should select as -Z. You will then be prompted to
"Measure -Z Plane", (if auto-direction is active "Measure Auto-Dir Plane").
Capture points A-1, A-2, A-3 and A-4 as shown in the figure above.

Step 2

Select Orient <j>. The orient command will create the primary datum on the axis
that is most normal to the machine coordinate system. In your PCS Setup Guide,
the Z-Axis will be signed off.

Step 3

Select Origin <l>. This will establish the Z origin that is determined by the normal
direction of the -Z plane.

Step 4

Select a 2D XY Point <5> + <2>. The selection of a 2D point requires two
commands. The first command is activated by pressing the < 5 > key, which will
display the 2D and 3D point selection tool, next select the PCS base plane you
would like to point to be projected into. After the selection has been completed,
Geomet Junior will prompt you to "Measure XY Point". Capture points B-1 and
C-1.
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Step 5

Select the Bisect command <a>. This command will take the two projected XY
points and solve for the 2D XY bisect point.

Step 6

Select Circle <z>, if auto-direction is not activated, you will be prompted for the
Circle type: ID, OD, IR, or OR, choose ID. Capture the four data points identified
as D-ID/4.

Step 7

Select Align <k>. This will take the just measured circle center and the previous
2D point created by the bisect routine and perform an alignment. Your ICS will
update to include the secondary datum.

Step 8

Select Origin <l>, the Circle, which is 2D, provide two directions when
establishing an origin. In our example, the circle can be used for the X and/or the
Y direction. The origin command will prompt you whether to use the X and then
the Y. For our example you should answer <Yes> to both requests. Upon
completion, you will have established PCS #1.

Summary

In this exercise, we used a constructed feature, an XY point, as part of the
alignment solution. It is important that you choose the correct features to be used
for alignment based on the completeness of the ICS. The XY points for B-1 and
C-1 were chosen as the ICS lacked an alignment. If two 1D points were chosen,
then there would exist an error caused by the part skewed to the MCS base axis,
see Chapter 4 Measurement Features ⇒ Points.

This does not preclude conditions where 1D points could have been used. For
example, if we were working in the PCS that was created in exercise 1, then we
would have the correct probe compensation vector and we could select -X and +X
1D points for B-1 and C-1 respectively. The resulting bisect would create a 1D
point on the centerline of the slot.

A 1D point followed by a circle can not be combined to form an alignment.
Geomet Junior does not accept this as it causes potential repeatability problems
when the slot is not aligned with the current PCS. Therefore you could repeat the
bisect of two additional 1D points captured on the width of the part at the other
end from the slot points C and D. The resulting 1D point derived from the bisect
combined with the previous recalled constructed point could produce the
alignment.
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PCS Building Example #7: Cylinder - Circle - Point

In this exercise we will utilize a cylinder to provide the primary datum and the
pierce point from the cylinder as the origin. The alignment will be supplied
through a circle and the previous cylinder. Finally a 1D point will complete the
part coordinate system by providing the last component of the origin. The
following example assumes the part is placed on your CMM where the cylinder of
the Widget is pointing in the -X direction.

Step 1

Select Cylinder <c>, if auto-direction is not activated, you will be prompted for
the cylinder type ID, OD, IR, or OR, choose ID. Capture the six data points
identified as A-ID/6, see the figure above.

Step 2

Select Orient <j>. The orient command will create the primary datum on the axis
of the cylinder that is most parallel to the machine coordinate system. In your
PCS Setup Guide, the Z-Axis will be signed off.

Step 3

Select Origin <l>. This will establish the origin reported as the pierce point of the
cylinder. In this example, the cylinder pierces the XY base plane and the origin
command will prompt you whether or not to set the origin on the X and/or the Y.
Answer yes to establish the XY origin.

Step 4

Select Circle <z>, if auto-direction is not activated, you will be prompted for the
Circle type: ID, OD, IR, or OR, choose ID. Capture the four data points identified
as B-ID/4.
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Step 5

Select Align <k>. Your ICS will update to include the secondary datum which is
derived from the XY circle and the previous XY pierce point from the cylinder.

Step 6

Select -Z Point <2>. The final component missing for your complete PCS is the Z
origin. You will then be prompted to "Measure -Z Point". Capture point C-1.

Step 7

Select Origin <l>. This will solve the Z-axis Origin and complete PCS #1.

Summary

When using a through bore as the primary datum, we must be careful that the data
point spread is sufficient to allow for a stable feature. In this example we would
place an extension on the stylus to allow for a greater reach into the cylinder.
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PCS Building Example #8: Plane - Intersect Lines - Bisect Points - Circle

In this exercise we will combine two constructed features to create the secondary
datum. These constructed features are derived from two lines intersected and two
2D points bisected. The following example assumes the part is placed on your
CMM where the cylinder of the GeoWidget is pointing in the -X direction.

Step 1

Request a -Z plane <b>, if auto-direction is not activated, you will be prompted
for the probing direction which you should select as -Z. You will then be
prompted to "Measure -Z Plane", (if auto-direction is active "Measure Auto-Dir
Plane"). Capture points A-1, A-2, A-3 and A-4 as shown in the figure above.

Step 2

Select Orient <j>. The orient command will create the primary datum on the axis
that is most normal to the machine coordinate system. In your PCS Setup Guide,
the Z-Axis will be signed off.

Step 3

Select Origin <l>. This will establish the Z origin that is determined by the normal
direction of the -Z plane.

Step 4

Request a Line <m>, You will then be prompted to select the probing direction,
enter -X (if auto-direction is not active). The prompt will update to display
"Measure -X Line" (or "Measure Auto-Dir Line"). Capture points B-1 and B-2.
When the points have been captured, you will be asked which projection plane to
use, select XY. A secondary request may be made to determine the pierce axis,
select X, refer to Chapter 4 Measured Features ⇒ Line for more information.
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Step 5

Clear the current mode by pressing the < Esc > key. Request a Line feature <m>,
You will then be prompted to select the probing direction, enter +X (if auto-
direction is not active). The prompt will update to display "Measure +X Line" (or
"Measure Auto-Dir Line"). Capture points C-1 and C-2. When the points have
been captured, you will be asked which projection plane to use, select XY.

Step 6

Select the Intersect <d> command. This command will take the two projected
lines and solve for the intersection between them. The result will be a 2D XY
point.

Step 7

Select a 2D XY Point <5> + <2>. The selection of a 2D point requires two
commands. The first command is activated by pressing the < 5 > key, 2D and 3D
point selection, which will then prompt which current base plane you will project
into. After the selection has been completed, Geomet Junior will prompt you to
"Measure XY Point". Capture points D-1 and E-1.

Step 8

Select the Bisect <a> command. This command will take the two projected XY
points and solve for the bisect between them resulting in a 2D XY point.

Step 9

Select in the report display feature number 7 by left clicking on it (2D point
formed by the intersect command). Right-click your mouse and select from the
popup sub menu, <Recall Feature>. This will recall the feature and create new
feature number 11.

Alternatively you can recall a feature by pressing the Recall Feature <h>
command from the keyboard. In the control labeled "<- Enter Feature No. to
Recall, enter 7 and press the <Ok> button or the <Enter> key on the keyboard.

Step 10

Select Align <k>. Your ICS will update to include the secondary datum which is
derived from the recalled 2D XY point and the previous 2D XY point created
from the bisect command.
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Step 11

Select Circle <z>, if auto-direction is not activated, you will be prompted for the
Circle type: ID, OD, IR, or OR, choose ID. Capture the four data points identified
as F-ID/4.

Step 12

Select Origin <l>, the Circle, which is 2D, provides two directions when
establishing an origin. In our example, the circle can be used for the X and/or the
Y direction. The origin command will prompt you whether to use the X and then
the Y. For our example you should answer Yes to both requests. Upon
completion, you will have established PCS 1.

Summary

In this exercise we had combined features to create constructed features which are
then used to create part coordinate system components. In part production we will
find numerous cases where one or more part coordinate system datums are
symmetry lines or points where no features exist.

When performing constructions in an ICS, it is important to remember the
established projection base planes that are valid. For example, in this exercise it
would not have produced acceptable results if we established 2 ZX points, one
each on the top and bottom surfaces of the widget and then perform the bisect.
The resulting 2D point would be projected into the alignment of the machine
coordinate system and therefore would not represent a valid point feature for the
part coordinate system.
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PCS Building Example #11: Translate

In this exercise we will take an existing part coordinate system and translate it by
nominal amounts in the X and Y-axis. The Translate command can be performed
on X, Y and/or Z individually or any combination. As you must have a complete
coordinate system defined, please setup your part described in PCS Example #2.

Step 1

Select the Translate command <;>. When you activate this command, Geomet
Junior will display a dialog where you can enter your translation values. Enter
2.125 for X and 1.500 for Y and no entry for Z. Press <Accept> to perform the
translation. A new PCS will be established, or in the case of Junior, a translation
of the current PCS takes place.

Summary

In many conditions, it is required to translate the part coordinate system when you
are working with a datum that is derived from points that are not defined on your
part. For example you may be inspecting a cavity insert which was removed from
a progressive die where the datums are a common alignment pin not available at
inspection time. Another example is the focal point of an optical lens whose
surface radial may be projected 2,000" from the actual part.
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PCS Building Example #12: Rotate

In this exercise we will take an existing part coordinate system and rotate it about
an axis by a nominal value. The rotate command can be perform only about one
PCS axis at a time. If you require performing compound rotations, the rotate
command must be repeated as separate steps. As you must have a complete
coordinate system defined, please setup your part described in PCS Exercise 2.

Step 1

Select the Rotate command, press <shift> + < : >. When you select this command,
the Rotate PCS Axis dialog will prompt you to enter a nominal value for an axis.
Rotations can only be applied to one axis at a time; therefore this rotation tool will
ensure you enter only one value prior to accepting the nominal value. For this
exercise, enter -5 in the X axis control and press the < Accept > button. A new
PCS will be established, or in the case of base Junior, a translation of the current
PCS takes place.

Summary

When we rotated the PCS -5° around the X-axis, our resulting PCS should be
parallel to the top surface of the tapered planes located on the taper end of the
GeoWidget. To verify that we performed the rotation correct, select a -Z Point
<2> feature and probe the top surface of the 5° plane. We should see a -Z point
value at .018 ± .005.
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Coordinate System Manager – Geomet Junior

Geomet Junior only has the capacity of one Coordinate System (CS). This CS can
be changed through all the CS system commands as previously defined. However,
it always replaces the previously defined CS.

The Coordinate System Manger toggle between the MCS and the defined PCS.
Pressing the key < ' > or through the menu [PCS ⇒ Recall PCS] will tpggle
between the two CS.

Coordinate System Manager – Geomet Junior Plus

The CS Manager provides access to recall established Part Coordinate Systems
and Machine Coordinate System.

Recalling a Part Coordinate System

Each time a completed PCS is established, it is given an ascending number
starting with 1. If you are requesting a PCS recall, activate the Coordinate System
Manager by pressing the key < ' > or through the menu [PCS ⇒ Recall PCS].
When the CS Manager appears ensure that the PCS button is pressed in the Select
Type group. Any existing PCS can then be made the current PCS by entering the
desired PCS number. Optionally you can utilize the slider control next to the
"Select Type" group to scroll through the available PCSs. If you were to enter a 0
for the desired PCS, you are in effect recalling the machine coordinate system.
Press the <Ok> button to complete the recall function.

Recalling the Machine Coordinate System

Recalling the Machine Coordinate System can be accomplished by activating the
Coordinate System Manager as described above and ensure that the MCS button
is pressed in the Select Type group. Press the <Ok> button to complete the recall
function.

NOTE: You will notice two additional buttons labeled FCS and Vector. The FCS
works with Fixture Coordinate Systems and Vector established drive vectors in
DCC style CMMs. They are used with Geomet 101 and above.
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Introduction to Tolerance

Before we discuss how Geomet Junior applies tolerance to a feature, it is useful to
review the various reporting formats available. These formats include Linear or
True Position tolerance reported in either Cartesian or Polar formats. All feature
locations are reported against a Datum Frame Reference or PCS (Part Coordinate
System). A two-dimension feature will report its location in one PCS base plane.
An example would be an XY Point consisting of an X and Y-axis component
relative to an origin, see example below.

The example above illustrates how the location of a point Pt1, (example would be
a center of a bore) can be expressed in either Cartesian (X, Y) or Polar (r, AX/Y)
coordinates. In the Cartesian format the coordinates X and Y are the distances
between Pt1 and the origin as measured along the X and Y-axis respectively. In
the Polar format, r represents the straight-line distance between Pt1 and the
origin, and AX/Y represents the angle that the radius line makes with the X-axis.

Geomet Junior defaults to Cartesian format, which can be changed in the System
Options. To change the reporting format during the teaching of a part inspection,
press the <e> (Cart/Pol) key on the keyboard. To change the reporting format of a
single feature, highlight the feature and activate the sub menu with a right click.
Choose either Cartesian or Polar from the Feature Characteristics command.
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Linear Tolerance Theory

The purpose of measurement is to determine the locations and sizes of features
relative to their specified upper and lower tolerance limits. The space between
these limits is called the Tolerance Zone.

Linear tolerance is sometimes referred to as Unilateral or bilateral tolerance.
Typical linear tolerance call outs are shown in the figure below.

Plus and Minus Tolerance

The shape of a linear tolerance zone depends on the dimensionality of the feature
in question and on whether the reporting format is Cartesian or Polar. The figures
below demonstrate a bilateral tolerance zone for a one-dimensional and two-
dimensional feature reported in Cartesian format.

1D Bilateral Tolerance
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2D Bilateral Tolerance
The next figure demonstrates the tolerance zone of a 2D feature in polar format. A
3 dimensional feature will have a cubic tolerance zone surrounding the XYZ
nominal point.

Bilateral Tolerance in Polar Format



Chapter 6 – Tolerance

Helmel Engineering Products, Inc. Geomet Junior Training Handbook
www.helmel.com www.geomet-cmm-software.com

6-6

True Position Tolerance Theory

Geomet Junior provides True Position tolerance support for qualifying features in
RFS, MMC and LMC formats. Additionally, Datum Bonus Tolerance is available
when building a Datum Frame Reference (PCS) using a bore and an origin
feature.

Definitions for most functions can be found in the ASME y14.5M-xxxx
specification. The manual is provided by ASME and can be found on their web
site: http://www.asme.org

The Linear tolerance zones previously discussed were found to have widely
varying shapes depending on the print-out format, Cartesian or Polar and on the 1,
2 or 3 dimensional nature of the feature. Positional Tolerance Zones are much
simpler by comparison being circular, cylindrical, spherical or conical in shape.

In Geomet Junior, Positional Tolerance is limited to circular and spherical zones
only and operates on the following features:

1D Pt 2D Pt 3D Pt Circle Line Plane Sphere Cylinder Cone
Pos. Tol. X X X X X(1) X(1)

Notes:
1 – Positional Tolerance is applied to the 2D Reported Pierce Point only.

table 1, Positional Tolerance Application Chart

A typical MMC positional tolerance zone, greatly magnified, is shown in the
figure below followed by a definition of terms:

MMC Positional Tolerance Zone Definitions

 Positional Zone Definitions:
P Nominal Point Location
P’ Actual Point Location

NPD/M Nominal Position Diameter MMC
EPD/M Effective Position Diameter MMC
APD/M Actual Position Diameter MMC
PAX/Y Position Angle relative to the X axis
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Whereby the effective position diameter (EPD/M) is the sum of the nominal
position diameter (NPD/M) and the tolerance bonus from the measured feature.

In this example, the feature is obviously in tolerance, because the actual position
diameter (APD/M) is less than the Effective position diameter (EPD/M).

Note that the position angle (PAX/Y) records the direction in which the actual
point is offset relative to the nominal point. The APD/M and the PAX/Y
completely define the location of the actual point. A typical positional tolerance
printout for a Circle is shown on the following examples.

Geomet Junior On-Screen Position Tolerance display

Geomet Junior Printed Report
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Working with Geomet Junior Tolerance Windows

Tolerance 1D Points Enter Feature Number

To activate the tolerance tool directly from the displayed report, highlight the
feature by left clicking on it. Activate the feature sub menu by right clicking and
select the [Edit Tolerance] command. To activate the tolerance tool using
keyboard short keys, press <Ctrl> + <t> which activates a dialog where the
feature number will be entered. In either method, the appropriate tolerance dialog
will appear with the current tolerance data displayed.

To apply tolerance nominal values, start by entering the nominal value for the
reported feature in the column labeled "Nominal". Next enter the Plus and Minus
values for the bilateral tolerance band.

NOTE: Geomet Junior will assist by entering the sign of the nominal
automatically. This is accomplished by using the sign of the actual reported value
that is added to the first number entered eliminating keystrokes.

Additionally, when you enter the plus tolerance band value, Geomet Junior
automatically updates the minus tolerance band eliminating extra keystrokes.

In some cases the bilateral tolerance band may not be equilateral, as with ±0.005.
An example might be where the tolerance band is +0.005/-0.002. Enter in the Plus
column "0.005" and in the Minus column "-0.002". The minus sign in the Minus
column must be entered to correctly calculate the actual position within the
tolerance band of +0.005/-0.002. The process of requiring the sign allows
tolerance bands such as +0.010/+0.002, or -0.002/-0.010, which are still in use on
assembly drawings.

To apply a Unilateral Tolerance, such as 10.0 +0.01 / 0.0 enter the 10.0 in the
nominal column, 0.01 in the plus column and 0.0 in the minus column.

To support Limit Dimensioning where the feature has a tolerance using hard
values such as 10.0 / 10.2, we suggest entering either 10.0 +0.02/0.0 or 10.1
±0.01.
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On every tolerance dialog, there exists radio buttons to assign a Tolerance Preset.
It would only be required that the nominal value be entered followed by the
selection of a tolerance preset. For further explanation on tolerance presets, please
refer to System Options. To assign a tolerance preset, press the <Alt> + <2> key
combination to assign tolerance preset #2 or left click with the mouse on the
selection.

Not all data fields are required to contain data. If you are required only to
tolerance the X value on a XY Point feature, enter the X nominal and leave the Y
nominal blank. Geomet Junior will then report only the tolerance data on the X-
axis values.

TIP: It is more efficient to move between edit controls using the tab key or the up
and down arrow keys on the keyboard. The order of movement on the tolerance
dialog utilizing the tab key is Nominal ⇒ Plus ⇒ Minus with each press of the
<tab> key. Should you want to reverse that order, press <Shift> + <tab>. The
<Enter> key at any time solves the application of the tolerance data and closes
the tolerance tool. To navigate only between the edit controls in the Nominal
column, use the up and down arrow keys. It is not necessary to locate the mouse,
which in this case, makes the tolerance tool very inefficient.



Chapter 6 – Tolerance

Helmel Engineering Products, Inc. Geomet Junior Training Handbook
www.helmel.com www.geomet-cmm-software.com

6-10

Working with True Position Tolerance Windows

On valid features, True Position Tolerance may be applied through the standard
Tolerance Window. Activating the True Position Window is accomplished by
selecting the tab assigned to True Position and labeled “Tolerance – MMC / LMC
/ RFS”.

3D Point True Position 2D Circle True Position

The example above shows the True Position Windows for a 3D Point and a 2D
Circle. The Tolerance Window will show data fields specific to the feature. In
some cases, such as a 3D Point where no form is provided, the MMC and LMC
options will not be available.

To obtain the correct True Position reporting, it is important that all data fields are
completely filled out.

To switch between MMC, LMC and RFS, left click on the appropriate symbol. If
your current PCS contain a Datum Bonus Tolerance, that value will be reported to
the right of the check box labeled “Apply DBT”. To use the DBT value in the
final solution, place a check mark next to the “Apply DBT”
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Interpreting Linear Tolerance in Geomet Junior

Using a 3D Point as an example, the figure below demonstrates what Geomet
Junior reports on the computer display and the next figure the printed result.
Please pay special attention to the manner in which "Dev. Tol." (Deviation from
Tolerance) is expressed. Geomet Junior displays an actual deviation value when
an out-of-tolerance condition exists. This number is the actual deviation from the
upper or lower tolerance limit. By contrast, plus and minus symbols are used to
indicate an "In tolerance" condition and simultaneously provide a measure of
tolerance bandwidth utilization. In particular, each plus or minus sign represents
25% of the upper or lower tolerance bandwidth respectively.

The following table illustrates examples of the Dev. Tol. column with symbols
and out-of-tolerance conditions

+ the actual lies between 0 and 25% of
the plus tolerance bandwidth.

-- the actual lies between >25% and <=
50% of the minus tolerance bandwidth.

+++ the actual lies between > 50% and <=
75 % of the plus tolerance bandwidth.

0.0055 the upper tolerance limit has been
exceed by 0.0055.

When Geomet Junior prints a report, the "Dev. Tol." column provides a scalable
graph, which represents the location within the tolerance bandwidth, that the
actual is placed.
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When an out-of-tolerance condition exists, the "Dev. Tol" column prints a value
that represents the deviation from either the plus or minus limit. The "Dev. Tol."
graph is available by default on all printed reports. Should you elect to always
display the deviation value, the setting can be found in System Options, Report
Config page.

Datum Bonus Tolerance

Datum Bonus Tolerance, (DBT) is available in a Part Coordinate System that has
been built using a diameter as the origin. The DBT process will determine the
amount of MMC or LMC available from the measurement of the diameter. This
DBT value is then included when working with positional tolerance related
features.

Determining DBT

To determine the value of DBT available in Geomet Junior it is mandatory to
follow these steps. Our example will use a 2D XY bore as the origin for our PCS
being built. Measure the bore as a Circle and apply a tolerance to the size. By
applying the tolerance, Geomet Junior can then determine the LMC or MMC
value from the tolerance limits.

When the tolerance has been applied, press the Origin key, <l> or the menu [PCS
⇒ Origin]. Set the origin on both the X and Y directions. During the origin
process, Geomet Junior will assign the DBT value to the projection plane, in our
case the XY plane.

Applying DBT

Applying Datum Bonus Tolerance

Applying DBT to a qualifying feature is accomplished during the tolerance
process. In the feature tolerance dialog, the value of DBT is displayed in the
group titled "Datum Bonus Tolerance". Place a check next to the "Apply DBT"
and the Total Tolerance Zone will update with the new value.
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GeoTol – Form Tolerance

Keyboard: t

Menu: Tolerances ⇒ GeoTol Form Tolerance

All GeoTol functions are combined in the single function which when activated
determines the appropriate geometric element based on the feature type. The
following table lists the available geometric elements for each feature type.

Geometric Element Associated Feature Type
Angularity Line, Plane, Cylinder, Cone
Circularity Circle, Cylinder

Cone, Sphere
Concentricity 2D Points, Circle, Cylinder, Cone,

Line, PCS Origin, Related Feature
Cylindricity Cylinder
Flatness Plane
Parallelism Line, Plane Cylinder, Cone,

PCS Base Planes
Perpendicularity Line, Plane, Cylinder, Cone,

PCS Base Planes and Axes
Straightness Line

The GeoTol wizard can be configured to work in the following modes:

Current PCS: In this mode, GeoTol references the last measured or constructed
feature to the current PCS. Example; if the last feature is a circle, then GeoTol
will validate the choices to Circularity and Concentricity to the PCS Origin. If the
last feature was a cylinder, then GeoTol validates the choices to include
Angularity, Concentricity, Cylindricity, Perpendicularity and Parallelism.

Last Feature: In this mode, GeoTol references the last measured or constructed
feature to the previous compatible feature. For example; if the last two features in
your inspection report are two XY Circles, the GeoTol tool will validate
Circularity and Concentricity.

Other Feature: This mode is similar to Last Feature, however it allows you the
choice of selecting a feature by number. For example, if your last feature is #29
and is a 2D Circle you can reference it to #12 also a 2D Circle to obtain
Concentricity. It is not necessary to work exclusively on the last two features in
your inspection report.

Circularity, Cylindricity and Flatness work exclusively on the last measured
feature without regard to the mode selected.
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A well thought out process should be considered when using GeoTol functions to
obtain results. To ensure sound results always consider using a large set of data
points for defining the feature. For example taking 4 data points to define a circle
may deliver acceptable results for size and location, but is insufficient to provide a
circularity result. At the minimum, Geomet Junior suggests a minimum of 16 data
points on smaller circles from which you want GeoTol results.

RunOut – Cylinder / Plane

Menu: Tolerances ⇒ RunOut ⇒ Cylinder/Plane

Not all GeoTol functions are accessed through
the GeoTol wizard. Some special cases are
separate functions such as the RunOut between
and Plane and Cylinder. The Cylinder / Plane
Runout routine is designed to calculate the
runout deviation of a Cylinder that is
perpendicular to a plane at a given radial
distance. This calculation would be similar to
placing a test indicator on the end of a cylinder whose lateral position is fixed.
The indicator would be placed in a fixed position identified as the radial distance.
The part would be turned slowly and the Total Indicator Reading (TIR) would be
recorded, see figure.

Setup for a Runout

The first requirement to making this routine successful is to measure a cylinder
and plane with sufficient data points. Under these conditions the cylinder and
plane should be measured with at least 30 points, more if necessary to locate a
representation of the variances within the surface.

When performing the Runout test manually, as shown in the example above, you
are actually capturing millions of data points while rotating the part. The indicator
will show a displacement from the highest to the lowest reading. This spread will
represent the Runout.

A CMM, which builds features using discrete numbers of data points will often
never locate the total spread. The features are created using a best-fit algorithm.
The result will contain a small uncertainty between the reported feature and the
actual work piece.  Therefore the higher the number of data points used, the
greater the chance you will return a runout that resembles the manual method.
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Determining the RunOut Value

Once you have completed measuring the Cylinder and Plane, activate the Runout
routine, through the main drop down menus
[Tolerances⇒RunOut⇒Cylinder/Plane]. The Runout tool will appear.

Cylinder/Plane Runout Tool Feature Selection Tool

Step 1 – Select Cylinder

Press the <Choose Cyl> button and the Feature Selector will appear with a filter
activated to show only Cylinders in your inspection report, see figure Feature
Selection Tool. Highlight the cylinder required for the Runout routine and press
<Ok>.

Step 2 – Select Plane

Press the <Choose Plane> button and the Feature Selector will appear with a filter
activated to show only Planes. Highlight the plane required for the Runout routine
and press <Ok>.

Step 3 – Set the Radial Test Length

In this step, enter the radial distance from the axis of the cylinder you would like
the runout to be calculated at. This can be explained as the location you would set
the test indicator at.

Step 4 – Allowable Tolerance Zone

This runout tolerance value is the total allowable deviation of the actual TIR
value. If the calculated deviation exceeds this amount, it is considered out-of-
tolerance.
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<Calculate> Button

The Calculate button updates the Actual: data field and is an optional step before
building the inspection step.

<Auto PE> Button – Geomet Junior Plus

The <Auto PE> button is a push-on, Push-off button. When locked in the down
state, as shown in example on the previous page, Geomet Junior will
automatically attach a Print Exception flag on the result when it attaches the
inspection step, see Print Exceptions for additional information.

<Ok> Button

To record the results in the inspection report, press the <Ok> button. An entry
will be made, see figure below.

Runout Reported Results

Adjusting the Tolerance Limit

You can at any time adjust the
maximum allowable tolerance limit. To
start, highlight the feature in the
inspection report area and right-click to
activate the feature sub-menu. Choose
Edit Tolerance from the list and the
Tolerance Dialog will appear, see
figure. After making any necessary
changes, press the <Ok> button and the
reported results will be updated.
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Constructions

Geomet Junior has the capability to create new features derived from other
measured or constructed entities. During the inspection process, features are often
created to solve complex solutions. The constructions available include:

Bisect
Intersect
Angles
Distances

Selecting Features for Constructions

The process of selecting compatible features from your inspection for use with a
Construction command can be accomplished through three methods.

Method 1- Implicit Selection

This method assumes there are no highlighted features in your inspection report.
The construction command will then work exclusively on the last two compatible
features in your inspection report. The construction command will look through
transparent features such as state changes, text and other non-geometry entries
and extract two measured or constructed features for use in the construction.

Method 2 – Targeted Highlighting

The operator may elect to highlight two random features then invoke the
construction command. The construction command will extract those highlighted
features to solve for a solution. Care should be taken when selecting random
features to follow the rules of compatibility. These rules vary based on the
construction command being applied. Where utilizing 1D and 2D features, the
selected features must share the same PCS, which is also the current PCS.
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Bisect

The Bisector routine determines the bisecting or symmetry feature between
compatible features. For example, bisecting two non-parallel planes will result in
two alternative bisecting planes (90° apart). The operator may then select one.

The Bisect Command is activated by:

Keyboard: a

Menu: Construct ⇒ Bisect

The Bisect command requires two compatible features to create a solution. Should
it determine the features do not follow the compatibility rules an error message
will display and the command will abort.

Points Line
1D 2D 3D 2D 3D Circle Plane Cyl Cone Sphere

1D Pt. 1D Pt.
2D Pt. 2D Pt. 3D Pt. 2D Pt. 2D Pt. 2D Pt. 3D Pt.
3D Pt. 3D Pt. 3D Pt. 3D Pt. 3D Pt. 3D Pt. 3D Pt.

2D Line 2D Line 2D Line
3D Line

2D Pt.
3D Line

2D Pt.
3D Line

3D Line 2D Pt.
3D Line

2D Pt.
3D Line

Circle 2D Pt. 3D Pt. 2D Pt. 2D Pt. 3D Pt.
Plane Plane

Cyl 2D Pt. 3D Pt. 2D Pt.
3D Line

2D Pt.
3D Line

2D Pt. 2D Pt.
3D Line

2D Pt.
3D Line

3D Pt.

Cone 2D Pt. 3D Pt. 2D Pt.
3D Line

2D Pt.
3D Line

2D Pt. 2D Pt.
3D Line

2D Pt.
3D Line

3D Pt.

Sphere 3D Pt. 3D Pt. 3D Pt. 3D Pt. 3D Pt. 3D Pt.
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Intersect

The Intersect Command is activated by:

Keyboard: d

Menu: Construct ⇒ Intersect

The Intersect command determines the characteristics of the intersection of two
compatible features. Intersection works with the following combinations:

Points Line
1D 2D 3D 2D 3D Circle Plane Cyl Cone Sphere

1D Pt.
2D Pt.
3D Pt.

2D Line 2D Pt. 2D Pt. 1D Pt.
3D Pt.

3D Pt.

3D Line 3D Pt. 3D Pt. 3D Pt.
Circle 2D Pt. 2D Pt.
Plane 1D Pt.

3D Pt.
3D Line 3D Pt. 3D Pt. 2D

Circle
Cyl 3D Pt. 3D Pt. 3D Pt. 3D Pt.

Cone 3D Pt. 3D Pt. 3D Pt. 3D Pt.
Sphere 2D

Circle
3D Pt. 3D Pt.

The Intersect command requires two compatible features to create a solution.
Should it determine the features do not follow the compatibility rules an error
message will display and the command will abort.

Special Intersection Applications

Circle / Circle

The intersection between two Circles provides 1, 3 or 5 possible solutions. All
solutions are 2D Point features in the same PCS projection plane as the circles. In
left figure, we have two circles that intersect. In the right figure, we have two
circles that do not intersect, but can have valid solutions.

Intersecting Circles Non-Intersection Circle
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The chart below demonstrates the 2D Point assignment to the nodes shown in
figures on the previous page.

Intersecting Circles Non-Intersecting Circle Notes

Node 1 Tangent Point on Circle 1 Reported as 2D Point and
a miss distance.

Node 2 Tangent Point on Circle 2 Reported as 2D Point and
a miss distance.

Node 3 Mid Point between Centers, or
Single contact point on the circles.

Mid Point is reported as
2D Point and a miss

distance.
Node 4 Intersection Point 1 N/A
Node 5 Intersection Point 2 N/A

When the node selection is obscured in the graphics display, press the <Zoom In>
button will redraw the graphics to encompass only the nodes for easier selection,
see figure below.

Zoom-In Function Selecting a Node

Selecting a node can be accomplished through various means. The simplest
method is to move your mouse over a node in the graphics area. When the mouse
pointer touches a node, a small display is shown which will indicate the XYZ
position and node ID number. Left-click on the node and it changes into a circle
indicating that is the selected node. Press the <Select> button and the solution will
be inserted into the inspection report.

To view all possible point solutions, press the
<Show Points> button. The display will expand
to show the 3 or 5 possible solutions, see figure
5. You can select a node in the list by placing a
bullet next to the corresponding node ID.
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Circle / Circle - Single Point Solution

There exists one condition that results in one intersect solution. That is where the
circles touch at only one point. When asking for the Intersection, the system will
report the one solution in your inspection report. This point corresponds to node
ID number 3 from the table above.

However, when capturing measured results this condition is rare. When Geomet
Junior determines the two circle do not repeat the touching in only the one
selected point, or may not even intersect, the solution will default to the mid point
and miss distance.

Circle / Circle - Default Reporting

When teaching a part for auto-inspection, variances to the part during
manufacturing may affect the reported intersection solution. For example, the
circle may intersect resulting in 5 possible solutions during the self-teach phase,
but later during the inspection routine they fail to intersect resulting in 3 possible
solutions.

If the original solution to report was node #4 or #5 when they intersected, they
will report as node #3 during inspection.

Circle / Line

The intersection between a Circle and Line provides 1, 3 or 5 possible solutions.
All solutions are 2D Point features in the same PCS projection plane as the
features. In figure 6, we have two circles that intersect. In figure 7, we have two
circles that do not intersect, but can have valid solutions.

Intersecting Line/Circle Non- Intersecting Line/Circle
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The behavior of the graphic intersection tool for Circle/Line is the same as
described in Circle/Circle above. Please refer to that section for assistance.

Intersecting Circle/Line Non-Intersecting
Circle/Line

Notes

Node 1 Tangent Point on Circle Reported as 2D Point.
Node 2 Tangent Point on Line Reported as 2D Point.

Node 3 Mid Point between Node 1 and 2, or
Single tangent point.

Mid Point is reported as
2D Point and a miss

distance.
Node 4 Intersection Point 1 N/A
Node 5 Intersection Point 2 N/A

Circle / Line - Single Point Solution

There exists one condition when there can be one solution. That is where the
circle and line touch only at the tangent point. When asking for the Intersection,
the system will report the one solution in your inspection report. This point
corresponds to node ID number 3 from the table above.

However, when performing repeated inspections this condition is rare. When
Geomet Junior determines the two features do not repeat the touching in only the
one selected point, or may not intersect, the solution will default to the mid point
and miss distance.

Circle / Line - Default Reporting

When teaching a part for auto-inspection, variances to the part during
manufacturing may affect the reported intersection solution. For example, the two
features may intersect resulting in 5 possible solutions during the self-teach phase,
but later during the inspection routine they fail to intersect resulting in 3 possible
solutions.

If the original solution to report was node #4 or #5 when they intersected, they
will report as node #3 during inspection.
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 Angle

The Angle routine determines the angle between two reference features. Angle
works with the following combinations:

Line ⇒ Line Line ⇒ Plane
Plane ⇒ Plane Cone ⇒ Plane

Cylinder ⇒ Plane Cone ⇒ Cone
Cylinder ⇒ Cylinder

The Angle Command is activated by:

Keyboard: f

Menu: Construct ⇒ Angle

The Angle command requires two compatible features to create a solution. Should
it determine the features do not follow the compatibility rules an error message
will display and the command will abort.

The reported value between two features where one or more features are 2D
results in a single projection value. For example, the angle between a 2D XY Line
and ZX Plane, results in an angle reported in the XY PCS base plane.

2D Line 3D Line Plane Cylinder Cone

Angle derived
from :

Projected
Line Vector
into the PCS

Line Direction
Vector

Normal
Vector Axis Axis

The angle between two 3D features, such as a plane and cylinder reports the theta
angle, or if elected, the 3 projection angles.

To switch between theta and projection angles, highlight the angle feature in the
inspection report and right-click to activate the menu. Choose [Projection Angles]
when the current state is theta, or choose [Theta] when the current state is
projection angles.

Reported angles can be shown either as degree.decimal format or degree-minutes-
seconds.
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Distance

The Distance Command is activated by:

Keyboard: s

Menu: Construct ⇒ Distance

Features must share a common axis and are contained in the current Part
Coordinate System. For example a 2D XY Circle shares a common axis of Y with
a 2D line reporting the Y-axis pierce value. The XY Cylinder Axis Pierce Point
shares both the X and Y with the reported position of a 3D Sphere.

Should the distance routine determine there are no shared axes between the two
features, an error will be reported. The Distance routine utilizes the current
Reporting Format under the following conditions.

Reporting Formats

Cartesian: Calculates the results in X, Y, and/or Z values that are parallel to the
current Part Coordinate System.

Polar: Calculates the results in Radius and project angle components of 2D and
3D distance solutions. Should the distance routine determine only a 1D solution is
possible, the reporting format will default to Cartesian.

Special considerations should be taken when using the Distance function. For
example the distance between two -Z planes is calculated along the Z-axis of the
current Part Coordinate System. This may not reflect the desired results when the
data points used to calculate the planes are taken a distance from the PCS Origin.
Any parallel deviation between the planes will accentuate the distance value when
projecting to the Z-axis of the PCS.

The chart below illustrates the feature characteristics used in distance reporting.

Feature
Type Reporting Characteristics

Reporting
Axis

1D Point Reported position along the Current PCS Axis. 1D
2D Point Projected 2D Point in the reported PCS Base plane. 2D
3D Point Center XYZ Reported Position. 3D
2D Circle Projected 2D Point in the reported PCS Base plane. 2D

2D Line Projected PCS Axis Pierce Point. 1D
3D Line PCS Base Plane Pierce Point. 2D

Plane Project PCS Axis Pierce Point. 1D
Cylinder PCS Base Plane Pierce Point. 2D

Cone PCS Base Plane Pierce Point. 2D
Sphere Center XYZ Reported Position. 3D
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 Feature Recall

The Feature Recall Command is activated by:

Keyboard: h

Menu: Construct ⇒ Recall Feature

The Feature Recall Tool is designed to copy
an existing feature and append it to the
inspection report. The newly created feature is
considered a constructed feature and is not
measured during the inspection.

Some of the benefits of recalling a feature is
that the original feature is not manipulated where the recalled feature can be
changed to show other attributes or even to project it into a different PCS.

Care should be taken where recalling features into a different PCS from which it
was originally built in. For example to recall a 2D feature and force it to be
projected into a skewed PCS can result in erratic results.

Feature Recall Tool

Enter the number of the entity into the Feature Recall Tool to recall to the top of
the inspection stack. To complete the recall procedure, press the <Ok> button and
a new feature will be appended to the inspection report. Should you try to recall
features into a different PCS, you will be prompted with instructions. These
instructions will guide you to force a recall or recall the reported position as a 3D
Point that will eliminate projection errors.

On Demand Recall

You can select a feature in the inspection report and right click to activate the sub
menu. Select [Recall Feature] or [Recall Features] is more than one feature is
selected. This will perform the recall on demand.
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Recall PCS Base Components

The Recall PCS Base Components Command is activated by:

Keyboard: shift + H

Menu: Construct ⇒ Recall PCS Base Components

Part Coordinate Systems contains 3 orthogonal planes that define the XY, YZ and
ZX base planes. There is also a 3D Point that defines the origin. These
components can be recalled as constructed features.

Select a PCS Choose Component

When you activate the command you will be prompted to choose a PCS by its
number. If there is only one PCS, this step will be skipped automatically. The next
tool will allow you to choose one of the PCS components. Your choices are:

Button Description
XY Recalls a XY Plane
YZ Recalls a YZ Plane
ZX Recalls a ZX Plane
3D Recalls a the Origin as a 3D Point

The features created are compatible with all construction and tolerance tools.
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Construct New Features

The Construct Features Command is activated by:

Keyboard: g

Menu: Construct ⇒ Line, Construct ⇒ Circle, Construct ⇒ Plane

To perform the Construct Command, start by
measuring or recalling compatible features. For
example capture a series of circles around a bolt hole
pattern. Then fit a circle through those measured
circles to determine the location of the bolt hole
pattern as a single entity.

To perform the construct, press the <g> key to
activate the Construct Features dialog. Click on the
desired feature. In this example, click on the Circle
bullet. You will be prompted for the number of
features to use in the construction. Press <Ok> and
Geomet Junior will create a new Circle feature in
your inspection report.

A constructed feature can have tolerance attached and be used in PCS creations
and even other constructions.
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Understanding Auto Direction Sensing

Using auto direction on 1D Points can lead to erroneous reported values if used
incorrectly. Auto direction relies on a smooth approach, from you the operator, in
capturing of a data point. The process of determining the approach vector
involves the CMM interface card to maintain a rolling IJK vector based on the last
five reported values. The interface card updates the current position in the MCS
on a programmable time interval from 20 to 200 milliseconds.

Auto Direction Approach vector

When you are approaching your work piece, it is required that you make contact
while remaining in a ±45° approach, see figure above. In this example, if we
remained in the approach zone we will capture a data point that will be reported
as a +Y point. If the operator did not remain in the approach zone the 1D Point
might report a + or - X Point from which we will have to correct the probe
compensation error. Most common occurrence of an erroneous data point comes
from operators who approach the surface, and then pause during the approach and
attempt to make contact under extremely slow speeds, which causes variations in
the path toward the surface.

1D Point Correction Sub-menu (both styles shown)
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To correct the reported direction of a 1D Point, highlight the feature by left
clicking on it, then right-click to bring up the feature menu, as shown in the
previous figure. Select [Point Direction], which will offer a sub-menu, with all
six probing directions available. Choose the correct 1D Point direction and your
part inspection will update with the correct 1D Point. Note: Once a feature has
been referenced it can not be changed or edited. For example, if a feature was
used in the construction of a PCS, it will be locked from changes. This is
identified by the inclusion of a ¹ next to the feature number, example " 12¹ ".

Using Auto-Direction with multi-point features such as circle, lines and planes
can also incorrectly report feature characteristics. This occurs when capturing data
points inconsistently or by capturing data points at a high rate. As previously
mentioned, the calculation of the direction vector for the probe works off the
speed of the interface and should that rate of point capture be too high, the
changes in direction going toward, then backing off the data point will create a
poor direction vector.

Since touch probes can be adversely effected by speed so can the auto-direction
tool. We suggest the use of a smooth consistent approach speed when capturing
data points.

Activate Auto Direction Sensing

Activate the Auto Direction sensing by going to the System Options, <F9> or
[System⇒System Options] from the drop down menu. Place a check next to
Enable Auto Sensing. If your CMM interface does not supports Auto Direction
Sensing, the check mark will clear automatically.

During the inspection process you may require to control the Auto Direction
sensing manually. This can be accomplished through the Feature Measurement
Toolbar or by pressing the <u> key on the keyboard. The Geomet Junior Status
banner located on the bottom of the window will indicate the state of the sensing
option.
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Program Header

The Program Header displays when Geomet
Junior is first started, a new file has been
requested or when opening a file. The program
header provides the necessary fields to update the
report header for the inspection.

To activate the program header once the
inspection report has been started can be
accomplished through the drop-down menus
[Report Controls ⇒ Report Header] or by double
clicking in the report header area of the displayed
inspection.

There are additional functions the report header provides.

<Load Last>
Maintains a listing of the last five previously opened files which is located in a
drop down list next to the Load Last button. Once you select the file from the list,
press the button <Load Last> to open that file.

<Run File> - Junior Plus Only!
With an inspection file already opened, the <Run File> button enters auto-cycle
mode. To auto-cycle a file can also be done from the drop down menus [File ⇒
Run].

<Load Part File>
This operation performs the same function found in the drop down menus, [File
⇒ Open]. A test is performed to ensure you save any changes to the inspection
report already open.

<Recover File>
Geomet Junior maintains a backup file of your current inspection report while in
self teach mode. With the completion of a program step, the complete inspection
program is written to the hard drive as a backup. Should any unexpected problem
occur that causes potential loss of data, such as a power failure, the Recover File
process will read in the backup file. You should then be able to continue your
inspection.

A note of caution on CMMs that do not have a home position, you should run the
complete program after a recover to rebuild the Part Coordinate Systems before
continuing your inspection.
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Fixture Usage Data Fields – Geomet JuniorPlus!

Geomet JuniorPlus allows the tracking of up to
3 unique inspection identifiers for a part being
inspected. We call these identifiers “Fixture
Usage” from the original purpose where a
fixture ID was added to the inspection report.

An example on using these Fixture fields would
be to identify what machining center a
production part was manufactured on. The
manufacturing department may have many
machining centers all making the same part. We
had one company that used over 50 machining centers all making the same part!

When ready to measure, the operator could type in the note section of the header
the machining center ID. Unfortunately the notes section of the header does not
provide any sorting capabilities. The Fixture Usage fields do. When inspecting the
production, enter the machining center ID in the Fixture Usage fields and then
sorting can be done to group all production inspected on the machining center it
was produced on.

This is helpful when performing SPC on production. By default, Fixture Tracking
is not active. To activate fixture support, place a check next to Enable Fixture
Reporting on the Geomet JuniorPlus System Options page.
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Restart Program Header  - JuniorPlus Only!

At the end of an inspection run, the Restart
Options dialog will appear. There are 5 options
available after the inspection run.

<Restart>
Restarts the current inspection starting from step
1.

<Run Steps>
This command works with both manual and DCC
systems. When you select this function, the
Feature Selection tool will display the features in
the inspection report. Choose the feature that
Rerun will continue from. Geomet Junior will
then remove all steps from the last feature, up to
and including the feature you have selected.

On a DCC system, a Target Tool will appear to guide you safely to the starting
point. When you have placed the CMM at this starting point, press <Continue>
and the inspection will continue under DCC control from that location.

<New>
Starts a new inspection prompting you to save your current inspection file.

<Print Report>
Performs an On Demand printout of the complete inspection report in standard
format.

<Concise Report>
This function is reserved for Geomet 101 and above.
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Text Features

Geomet Junior offers several text and prompt support features for use within the
inspection program. This support varies based on inspection needs and includes
the ability to pause the inspection program during execution to allow the viewing
of an image or to change a manual-indexing probe. Choose from a topic below for
expanded support.

Basic Text

Keyboard: y

Menu: Measure ⇒ Text

The Basic Text routine permits comments to be written to the inspection report as
a feature step. This text is entered during the self-teach operation. When executing
the part program, the text is placed in the inspection report and proceeds to the
next step. During execution, the text can not be edited.

Manual Step Sample Output

Edit Text Features

All text features can be edited to revise the text or PE
tag. To start the editing process, highlight the text
statement in the inspection report and activate the
feature sub-menu by right clicking, see figure.

Choose <Edit Text> and the appropriate text dialog will appear from which you
can then edit the text.
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User Prompt with Image Support

Keyboard: shift + Y

Menu: Measure ⇒ User Prompt

The User Prompt permit comments to be written to the inspection report and
images to be displayed during the part program execution.

User Prompt Opening Dialog

The advantage a User Prompt has over the Basic Text function is that it suspends
execution of the part program until the operator accepts the user prompt. This can
be very helpful when the operator must interact with the inspection process. For
example: The User Prompt may suspend execution and prompt the operator to
insert a thread gage before measuring the location of a threaded hole.

To use the Image support, press the <Image> button. A standard Windows file
location dialog will appear which you use to locate the image (BMP, JPG) to
view.

Open File Selection User Prompt with attached Image

Once the image is loaded, the full path name is inserted in the text entry control.
You can type over this pre-entered text. If you want to preserve the path and file
name, position the cursor behind the text line and advance to the next line by
pressing <Ctrl+Enter>.
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Images that are larger than the available area in the dialog box will automatically
be reduced to fit. Images that are smaller are displayed in their actual size. The
<ReSize> button will stretch smaller images to fit the available area. Geomet
Junior maintains a link to the actual image file, therefore the image file should not
be moved from its original location on the hard drive.

When the inspection program is run, execution will pause when the User Prompt
is encountered. Execution will resume when the operator presses the <Ok>
button.

In-Line Text Entry – JuniorPlus Only!

Keyboard: alt + Y

In-Line Text Entry allows the user to suspend execution of a part program and
enter text. The behavior of the In-Line text feature is similar to the User Prompt
(without image support). When the pause in program execution occurs, the
operator then has an opportunity to enter new text. This text becomes part of the
final inspection report.

Enter instructions for In-Line Text During run time.

In the examples above, the image on the left is the setup dialog for In-Line text.
Here the programmer would enter instructions, which at run time, will instruct the
operator to add comments responding to the request.

The image on the right is what the operator would see. Only upon completion,
will the inspection continue to the next step.

Text entry made in the final inspection report.
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Edit Text Features

All text features can be edited to revise the text, and if
applicable, the attached image. To start the editing
process, highlight the text statement in the inspection
report and activate the feature sub-menu by right clicking with your mouse. If
only one feature is highlighted, the edit text dialog will appear. If more than one
feature is highlighted, the sub-menu does not provide access to editing the text
feature.
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Report Control Center – JuniorPlus Only!

Keyboard: F8

Menu: Report Controls ⇒ Report Control Center

The Report Control Center performs two main operations. The first is manual
control to print reports using the standard print format, but controlling whether
Print Exception, SPC Tags or Out-of-Tolerance conditions are set. The second
function is to add an automatic Print feature to the inspection report.

On Demand Printing

Activate the Report Control Center from the drop-down menu [Report
Controls⇒Report Control Center], when or press the function button <F8>.

To control the displayed and printed report, place a check next to the report
option.

Report Control Center

To view or print only features that have been tagged under Print Exception, place
a check next to Print Tags. To combine tags, you can place multiple checks
against an option.

Program Action Step

Configure your report by placing checks on the options to be included in the
printed report. Press the <Attach Step> button and an action feature will be added
to the inspection report. This new feature will automatically print the configured
report at the designated place in the inspection run.
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Print Exception / SPC Tags - JuniorPlus Only!

Keyboard: p

Menu: GeoPlus ⇒ Feature Tag

Feature Attribute Tags provide tools to customize printouts, assign feature
characteristics for ASCII exporting and build GeoStat database records. The most
common use for Tags is to produce inspection reports that contain only the feature
values you require.

Applying Feature Attribute Tags

The Feature Tag dialog provides the necessary tools to assign attribute tags. To
activate Feature Tags, highlight the feature in the inspection report and right-click
to activate the feature sub-menu. Choose [Feature Tag]. Optionally you may use
the keystroke <p> or menu options.

Feature Tag Control Panel Right Click Activation

The Feature Tag dialog will appear configured to the highlighted feature. Within
the dialog, there are three columns of check boxes that are defined as:

PE: Print Exceptions. When a check is placed against an attribute, the Report
Control Center will add that feature and attribute to the printed inspection report.
Only tagged features will be printed allowing control over the printing process.
The symbol " • " is placed next to the attribute in the full displayed inspection
report indicating it has been tagged.

SPC: ASCII Export Control. When a check is placed against an attribute, Geomet
Junior will export this attribute to an ASCII text file. The exporting process is
automatic during an inspection run, or can be done manually through the drop-
down menu selection [File⇒Export⇒Export ASCII SPC Data] The symbol " § "
is placed next to the attribute in the full displayed inspection report indicating it
has been tagged for SPC exporting. The configuration of the exporting formats is
controlled in the System Option, SPC Format page <F9> or [System⇒System
Options].
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GS: GeoStat Exporting. These attribute controls are available when the Helmel
GeoStat program is active on your system. When selecting an attribute for export
to the GeoStat Database, a control header is displayed where the SPC header
control can be updated. For more information on using GeoStat, please review the
GeoStat Manual.

Button Description
Modify Commits the current changes made to attribute tags to the current record.
Next Feature Retrieves the next feature from the inspection report and displays its current

values and attributes.
Clear Clears all flags on the current feature, commits the changes with the Modify

button.
More / Less Expands the Feature Tag dialog to show a slider which can be used to scroll

through the features in the inspection report.
1 Set Tags Activates a Feature Tag Default tool that allows customized default setting for

using the one-touch controls, Apply Tags and Tag All.
Apply Tags Applies the attribute tags to the current, highlighted feature for Print Exception

control based on the default tags set in the Feature Tag Default under 1 Set
Tags.

Tag All Applies the attribute tags to all features in the inspection report for Print
Exception control based on the default tags set in the Feature Tag Default
under 1 Set Tags.

SPC Applies SPC tags to all reportable attributes on the current highlighted
feature. Saves the changes and moves to the next available feature.

PE Applies Print Exception tags to all reportable attributes on the current
highlighted feature. Saves the changes and moves to the next available
feature.

Auto PE/SPC Applies SPC and Print Exception tags to all reportable attributes on the
current highlighted feature. Saves the changes and moves to the next
available feature.

Selecting Features

Report Control Center

There are several methods to move between inspection report features while in the
Feature Tag dialog. Using the <More> button will expand the dialog to show a
slider control, see example above. With your mouse, move the pointer, which will
retrieve and display a feature in the tag dialog. If you want to hide the slider
control, press the <Less> button.
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Using the keyboard left and right arrows will move the highlighted feature and
update the tag dialog. The left arrow moves to the previous feature with every
press. The right arrow moves forward. You can also type in a specific feature
number in the Feature Number control.

The <Next Feature> button behaves the same as the right arrow. NOTE: Use
<Modify> to commit the changes before moving to another feature.

Auto Tags Group

<SPC>, <PE>, <Auto SPC/PE>
This group of controls provides a single function to add checks for all attributes of
the current selected feature. Using a 3D Point in Cartesian format as an example,
press the <PE> button and two actions will occur. The first action will place a
Print Exception check on the X, Y and Z reported values. The second action will
move the feature pointer to the next feature available for tags.

Custom PE Tags Group

This group of controls applies a previously defined template of tags that controls
which attributes will receive a Print Exception tag. The application of this
template can be on a single feature, or the entire inspection report with one action.

<1 Set Tags>
This command provides access to the Feature Tag
Defaults Tool, which is used to build a Print Exception
template shown at right. There are three selectable
attributes for features. These are Position, Size and
Attitudes.

The Position column controls the PE flags for X, Y, and
Z reported positions in Cartesian and the Polar-Radius,
Polar-Angle in Polar mode.

The Size column controls the PE flags for all reported Width, Radius and
Diameter sizes.

The Attitudes column controls the PE flags for all reported 2D and 3D projection
angles and Normal Vectors of features.

The Feature Tag Defaults Tool can also be started outside of the Feature Tags tool
through the menu [GEO-Plus©⇒Set Feature Tag Defaults].
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<Apply Tags>
Selecting this command will apply the PE template on the current feature. Using
the template shown above on a measured plane will place a PE tag on the Pierce
Axis and will not place PE tags on the reported angles. After applying the tags,
the feature pointer will move to the next feature available for tags.

<Tag All>
This command will parse the entire inspection report and apply the defined PE
template to every feature. The command will not place tags on any feature that
does not show results. This includes features measured before a valid PCS is
established.

Tag Options Menu

Through this menu there are two commands. The
first command [Clear All Print Tags] will remove
all Print Exception tags in the entire inspection
report.

The second command [Clear All SPC Tags] will
remove all SPC tags in the entire inspection
report.
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Report Offset – JuniorPlus Only!

Keyboard: ctrl + y

Menu: GeoPlus ⇒ Apply Report Offset

The Report Offset Tool is used to apply a reference value to a reported attribute
on any feature. One example is the rotation of an angle to match the drawing. This
allows the printed inspection report to match the drawing. Using an example of a
2D XY Circle, we will apply an offset to the angle.

ID XY Circle [16 pts]
Cartesian Format Polar Format

ID= 0.5000” ID= 0.5000”
X= 4.3300” Pol-R= 4.9999”
Y= 2.5000” Angle= 30.0007°

Here we show the Cartesian and Polar formats for reference. The angle of
30.0007° is referenced off the x-axis going counter clockwise. The drawing
references the angle off the y-axis and has a nominal value of 60.0°. To make a
correction to the reported value, we can add a nominal offset value to the reported
angle.

Report Offset Tool

As shown in the Report Offset Tool, we entered a –90 in the Pol Angle: control.
The result to the reported angle is shown to the right.

ID XY Circle [16 pts]
Before After

ID= 0.5000” ID= 0.5000”
Pol-R= 4.9999” Pol-R= 4.9999”
Angle= 30.0007° Angle= -59.9993°

The Report Offset can be applied to any feature and any reported position. It is
carried forward to inspection runs.
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Junior Digital Readout

Keyboard: ctrl + d

Menu: View ⇒ On Screen DRO

Geomet Junior offers an on screen Digital
ReadOut. This DRO is configured to show the
location in the current Part Coordinate System
or in the Machine Coordinate System on
demand.

During the inspection process, the DRO will
automatically reconfigure itself to work in the
latest PCS or ICS and in the current reporting
format, Inch or Metric.

To change the precision depth shown on the DRO, right click on the DRO to
activate the popup sub menu and move your mouse over the [Digital Readout
Precision] option and choose a new decimal place value. This value will become
the new default.

Setting Precision Setting DRO Text Size

To change the size of the text, click on the DRO to activate the popup sub menu
and move your mouse over the [Digital Readout Height] option. Choose from one
of the three options. The font size you choose will become the new default.
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In-Line Math Calculator

Geomet Junior offers an In-Line Math calculator on supported Dialog Boxes. This
allows solving of simple math formulas when the operator enters data.

When a supported dialog box appears that has In-Line Math functionality it will
be identified by having a small calculator icon next to the supported control, see
figure below. Not all dialog boxes support the In-Line Math Calculator.

DRO Sub Menu Setting Precision Depth

When you see this icon, the edit control directly to the left will offer simple math
solving function. To use, begin by entering your formula in the edit control. For
example enter "2.0" in the edit control, as shown above. Next we press the
addition key “+” and Geomet Junior recognizes a math function is being
requested and displays a small calculator. NOTE: The In-Line Math Calculator
will activate when pressing one of the following:

• Plus <+>
• Minus <->
• Multiply <*>
• Divide </>

The initial value of "2.0" is passed into the calculator and the math symbol "+" is
displayed to the left of the lower edit control. Enter in the number to be added to
the upper number and press any of the math keys, " + - * / or =" which will solve
the current operation and transfer the new value into the upper display awaiting
another calculation.

To return the solution to the originating data field, press <Enter>.

Metric / Inch Conversion

The current value displayed in the upper display will be converted into metric
(mm) or inches by pressing the corresponding button. The In-Line math
Calculator makes no assignment to the values as they are calculated. By pressing
the <mm> button, the upper value will be multiplied by 25.4 and when pressing
<inch>, the upper values are divided by 25.4.
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Complete Table of In-Line Math functions:

Description
+ (Plus) Solves the function X + Y and returns the result in X.
- (Minus) Solves the function X - Y and returns the result in X.
* (Multiply) Solves the function X * Y and returns the result in X.
/ (Divide) Solves the function X / Y and returns the result in X.

= (Equal) Solves the current operation and transfers the result back to the X
position. This does not close the Calculator.

mm Converts the upper value (X) by multiplying it by 25.4.
inch Converts the upper value (X) by dividing it by 25.4.
Sqrt Converts the upper value (X) by determining its square root.
-/+ Changes the sign of the lower value (Y).
MC Clears any value stored in memory.
MR Recalls the value stored in memory in the lower value (Y).
MS Replace any value in memory with the upper value (X).
M+ Add the upper value (X) to the current value in memory.
C Clear X and Y, does not clear memory.

CE Clear the current lower value (Y).
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Inspection Program Editing Tools

Some Geomet Junior functions are active only in the self-teach and offline modes.
These tools are designed to modify the inspection program for feature placement,
feature modifications and report customizations.

Undo

Keyboard: Ctrl + U

Menu: Modify ⇒ Undo

The Undo command removes the last entry in the inspection report, and resets any
state changes that may have occurred. This command can be used repeatedly to
remove many features. It does not have a Redo option and therefore any features
removed can not be restored, see Edit History for advanced Undo options.

Delete

Keyboard: i

Menu: Modify ⇒ (Un)Delete

The Delete command marks a feature as being deleted in your inspection report.
A feature marked as delete is not acted upon in an inspection run. The Delete
command verifies that the feature has no references attached to it. These include
whether the feature was used in a recall, construction or is part of a PCS
component. When a feature has been marked as Deleted, The Delete command
will un-delete the feature and make it active again.

Accessing the Delete Command

There are several methods that can be used to activate the Delete Tool. Through
the keyboard, press < i >. To work directly in the inspection report, highlight the
feature and right click to activate the feature submenu and select [Feature
Properties].

Right Click Activation Feature Properties Delete Tool
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Deleting a Feature

To delete a feature, activate the Delete tool. Enter a Feature Number that specifies
the feature to be deleted. Press the <Ok> button and the feature will be changed in
the inspection report and marked as deleted.

If you are deleting the feature through the Feature Properties tool, place a check
next to “Deleted”.

Un-Deleting a Feature

To un-delete a feature, activate the Delete Mode. Enter a Feature Number that
specifies the feature to be un-deleted. Press the <Ok> button and the feature will
be changed in the inspection report back to its original state.

Delete Permanently

Menu: Modify ⇒ Delete Permanently

The Delete Permanently command removes a feature in your inspection report.
Unlike the Delete Command, the feature will be removed and the remaining
features will move up and be renumbered. The command verifies that the feature
has no references attached to it. These include whether the feature was used in a
recall, construction or is part of a PCS component.

Delete Permanently Tool Validation Warning Right Click Activation

To remove a feature, activate the Delete Permanently mode. Enter a Feature
Number that specifies the feature to be removed. Press the <Ok> button and the
feature will be validated to ensure there are no references attached it. If approved
it will be removed from the inspection report and all features after that will be
renumbered.

Removing a feature can also be done through the use of the mouse by highlighting
the feature in the inspection report and calling the submenu by right clicking.
Choose [Delete Permanently] to complete the operation.

NOTE: If the feature has references attached to it, Geomet Junior will prompt the
operator with a Validation Warning. The Delete Permanently command can not
delete any features that have references attached to it.
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Delete All After

Menu: Modify ⇒ Delete All Records After…

The Delete all Records After... command prompts for a feature number that will
become the last feature in the report. All features after that position will be
deleted.

Deleting Features from a Starting Point

To delete all features after a specified feature
number, activate the Delete All After Mode. Enter
a Feature Number, which specifies the last feature
to keep, and all features after this number will be
deleted. Press the <Ok> button and the inspection
report will update to reflect the command.

Geomet Junior will prompt you to confirm your
request.

Tip: If you highlight your feature in the inspection
report then activate the Delete All After tool, the
feature number will transfer into the dialog
automatically.

NOTE: When this command has been executed,
the features are permanently removed. Only through the use of the Advanced Edit
History Tool can they be retrieved.
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Insert

Keyboard: shift + I

Menu: Modify ⇒ Insert

Selecting a feature to insert after Insert Active Notice

Inserting a New Feature

To insert a new feature, activate the Insert Mode. Enter a Feature Number that
specifies where the insert will take place, see figure above. The new feature will
be after the feature number you have entered. Press the <Ok> button and the
Insert Notice will appear. When a new feature has been inserted, Geomet Junior
updates all feature numbers and record links to ensure references to features
remain intact.

Features that can be inserted:

• Measured Feature
• Constructed Feature
• Text and User Prompt
• Distance, Angle, Bisector and Intersect

Features that are blocked include:

• PCS Components
• Stylus Changes

Cancel the Insert Mode by pressing the Escape key.

NOTE: When inserting a new feature with a motion map attached to it, care
should be taken to ensure proper start and end IPs. After the new feature has been
added, review your motion map.



Chapter 8 – Support Tools and Features

Helmel Engineering Products, Inc. Geomet Junior Training Handbook
www.helmel.com www.geomet-cmm-software.com

8-25

Move

Keyboard: ctrl + i

Menu: Modify ⇒ Insert

The Move command allows the repositioning of a feature to another location
within the inspection program. Assurances are provided to prevent moving to
another PCS, or when the current probe is not the same as the feature's active
probe.

Selecting a feature to move Select a new position

To move a feature, enter a number of the feature to be moved, see figure above.
Press the <Ok> button then enter the location in the inspection report the feature
will be moved to. Press <Ok> and Geomet Junior will validate your request and
perform the move.

When the feature has been moved, Geomet Junior renumbers all feature numbers
and record links to ensure references to features remain intact.

TIP: Should you want to permanently delete a feature, such as feature number 15
of a 50 step inspection program. Start by moving the feature to the end of the
inspection report. Once this has been accomplished, Press <Ctrl + u> which is
the Undo command.
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Jump to Feature Number

Keyboard: ctrl + i

Menu: Modify ⇒ Insert

The Jump to Feature Number command repositions the report view by placing the
requested feature at the top of the display.

Jump To… Entry Dialog

Jump to a Feature Number

To reposition the inspection report to show a specific feature number, activate the
Jump to command, <Ctrl + g>. Enter the feature number that will become the top
feature in the display. Press <Ok> and Geomet Junior will scroll the inspection
report to ensure the requested feature number is visible.

NOTE: There is a special use condition for the Jump To Command during a part
inspection run, see Re-Run Inspection Steps.
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Feature Properties

Feature Properties tools in Geomet Junior allows the changing of states, access to
tolerance values and other feature specific information. To activate the tool,
highlight one or more features and in the report area, right-click your mouse.

Single Feature Selection Submenu Multiple Feature Selection Submenu

Single Feature Selection Submenu

When only one feature has been selected in the inspection report, activating the
Feature Properties tool provides an expanded set of commands, see left figure
above.

The expanded Feature Properties tool is constructed with common commands, see
left figure above, and feature specific commands, see right figure above. The
common tools are shared with all features. The feature specific commands change
to adapt to the selected feature.
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Single Feature Properties Tool

The Feature Properties tool is available when one
feature is selected and provides a single source to
control several characteristics of the selected
feature.

Feature Label
Enter a feature label that will replace the default
name for that feature. For example: a measured
plane is provided the standard name "-Z Plane",
to change the name enter a label such as "Left
Plane, PCS Base". This provides a more
descriptive text to identify features.

<Remove>
When a feature label has been applied, the
<Remove> button returns the feature name to its
standard label.

Feature States Group
Within this group there are several reporting states that can be set for the selected
feature. Choose the state by clicking on the bullet next to the choice or placing a
check next to the command.

Deleted
The feature Deleted flag controls the inclusion of this feature into the inspection
report. This check box is acted upon when pressing the <Ok> button.

Precision
Select a new precision value to be used when displaying and printing the selected
feature.

<Reset>
The <Reset> command returns the decimal place precision to the current default
setting as defined in the [System Options⇒Tolerance] page.
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Multiple Feature Selection Submenu

The Feature Properties can be changed on multiple records using the right-click
Sub-Menu command, see Multiple Feature Property Submenu. This method does
not provide controls to specific feature attributes.

A menu appears when you select Feature Properties, see Reporting States. This
menu provides access to report states and precision values.

To select a new precision value, select Decimal Precision and choose a new value,
see Precision Setting. To reset the precision value, select <#>.

Precision Setting Example
Geomet Junior will update all highlighted features with your requested changes.

NOTE: If the highlighted features are mixed reporting states or precision values,
this command will over write all settings to the common choice being made.

[Recall Features]
When the Recall Feature command is selected, each selected feature will generate
its own programming step, or transaction file entry which is appended to the
inspection report and will be operated on as a unique entity by other Geomet
Junior functions. For example, if features 16, 25, 26 and 32 are highlighted in an
89-step program, they will be appended as 90, 91, 92 and 93.

As in all Geomet Junior functions, feature validations are applied to ensure
credible recalls. These include ensuring the features being recalled are from the
same PCS as the current PCS to name just one. Feature links will be updated to
reflect any changes.

[Print Selected Items]
This command will generate a printed report consisting only of the highlighted
features. This is not a programmable step and is acted upon immediately.
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Report Navigation Keys

There are several key presses that compliment the standard Windows interface to
scroll and reposition through the displayed inspection report. In Windows, a list,
or report that exceeds the boundaries of the display will provide scroll bars
normally located on the right and bottom of the view. Using these scroll bars
requires the use of the mouse that controls the positioning by sliding the "Scroll
Box". For further assistance on using scroll bars, please review Help in Windows.

Geomet Junior provides shortcut key presses to control the positioning of the
inspection report in the available area on the display.

Geomet Junior Inspection Report Navigation Keys
Down Arrow Moves the inspection report down one line.

Up Arrow Moves the inspection report up one line.
Left Arrow Moves the Inspection report to the left one character.

Right Arrow Moves the Inspection report to the right one character.
Home Scrolls the report to show the Header (focus required).

Ctrl + Home Scrolls the report to show the Header (focus not required).
End Scrolls the report to show the last feature (focus required).

Ctrl + End Scrolls the report to show the last feature (focus required).
Ctrl + g Jump to a specific feature number.

NOTE: Windows sends all key presses to the Window or Dialog that has "Focus",
considered the current topmost active window. For example, if you have Geomet
Junior and another program, such as Excel active, the program that has "Focus"
will receive all key presses. If you press the <Home> key when the inspection
report is not the current "Focused" control, no response is seen.

To illustrate, open a long inspection report and click your mouse in the graphic
area. Press <Home> or <End> and the inspection report does not move. That is
because the graphic window has the current focus. Click your mouse in the report
area and repeat the key presses and the report will scroll according to your
commands.
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Introduction

Geomet Junior offers many tools to assist in reverse engineering. These tools
include feature data point scanning and exporting measured features and data
clouds as IGES entities.

Our Reverse Engineering tools have been developed to facilitate producing
accurate dimensional geometric CAD representations of unknown or
undocumented parts. Identifying prismatic features such as circles, planes, cones
and other defined geometric features combined with data clouds can then be
exported into a file format that a CAD system could read. The CAD system will
then analyze the information and form the solid objects or motion paths for CNC
tools.

Reverse Engineering for Surface Generation

The capturing of data points over an unknown surface utilizing a Coordinate
Measuring Machine produces a data point cloud of XYZ values. The values
represent the ball center of the stylus attached to the CMM. Touch probes are
triggered devices that do not provide information as to where on the stylus ball the
actual tangent point of the surface contact occurred.

Therefore, utilizing the data cloud in reverse engineering requires that the CAD
system must perform an offset surface command before the final solid is created.
To assist the CAD system, Geomet Junior offers controlled data point collection
tools and the exporting of fitted B-Spline Curves through the data points.
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Summary of Reverse Engineering Tools:

Manual Free Scan - Capturing of discreet data point clouds utilizing manual or
DCC CMMs. Includes support for electronic touch and hard probes.

GeoTracer – Hard probe drag scanning used on manual CMMs.

Cardinal Spline Generation - A cardinal spline is a series of individual curves
between points joined to form a larger curve. The spline is specified by an array
of points and a tension parameter. A cardinal spline passes smoothly through each
point in the array; there are no sharp corners and no abrupt changes in the
tightness of the curve. By passing through every point, there are no missed points
that can cause errors when fitting a surface over the splines.

Exporting IGES Entities - Export tool used to create an IGES file useful when
sending data to a CAD system.
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Manual Free Scan

Keystroke: /

Menu: Measure ⇒ Perform Selected Scan

This method requires the operator to perform the actual capturing of data.

Capturing a Data Cloud

The operator manually captures data points by making contact with the surface.
Points are entered either using an electronic touch probe, or depressing the foot
switch when using hard probes. The XYZ recorded data represents the ball center
of the stylus.

Controlling the Data Cloud

This method does not produce a controlled capture of data. It relies on the
operator to capture the data cloud in some uniform procedure. If capturing with a
manual CMM, it is helpful to lock an axis, such as the x-axis, and capture data
points moving in the Y direction. Then unlock the X-axis and reposition to a new
X location and repeat the process to create a new column of data.

Creating columns of data points will be easier to manipulate by a CAD system if
it is required to build a surface.

When sufficient data points have been captured, press the < F5 > function key to
record the data points.
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GeoTracer

Menu: Measure ⇒ GeoTracer

GeoTracer is one member of the Geomet Junior Suite of Reverse Engineering
Tools. GeoTracer is designed to capture large data point clouds using a hard ball
probe by dragging the probe over a surface.

When activating the GeoTracer tool, you will be presented with a dialog there you
set the performance characteristics.

GeoTracer Setup Tool

Target Distance between Points:

The value entered becomes the length Geomet Junior will use to establish the
minimum distance between data points. When GeoTracer is in motion, the CMM
sends a constant stream of data points to Geomet Junior. The first data point
captured will be stored and all incoming data points will be compared to the first
point until the distance between points exceeds the target distance. Once that
minimum distance has been met, the second point will be captured and the
process repeats itself.

Maximum Data Points per Line:

The value entered here will limit the size of a single data cloud that is stored as a
single feature. Once the data cloud size equals this value, Geomet Junior will
create a new feature in the inspection report that contains the captured data points.
Geomet Junior will then recycle the GeoTracer allowing you to continue
capturing data without stopping. The purpose of limiting your data cloud size is
only for convenience to limit how much data will be included in one feature.
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Capturing Data with GeoTracer

When you close the GeoTracer parameter dialog, you will be prompted to capture
data points.

GeoTracer Probe Disabled Prompt

When the prompt appears, the capturing of the data points is suspended allowing
you time to move the CMM into position on your part. This is indicated by the
*** Probe Disabled *** statement next to the Current Status prompt.

When you are ready to capture data, press the <space bar>, or depress the optional
foot switch. Geomet Junior will now capture data when you start moving your
probe across the part. Pressing the space bar again will cause Geomet Junior to
return to a Disabled Probe state and create a feature with the captured data points.

The Captured Data Cloud

The data points being captured will be the XYZ location of the probe ball center.
Since probes do not offer vector feedback informing the host measuring software
where the contact point was on the ball, a determination of surface points is not
possible. This condition can be corrected by exporting the data clouds to most of
the popular CAD software systems and then constructing a surface followed by
offsetting that surface by the probe radius.

Useful Tips

If your intent is to take the data clouds and export them to a CAD system, it is
helpful to organize how you capture the data clouds. Most manual CMMs offer
locking mechanisms on the X, Y and Z-axes. This allows you to lock one axis and
drag the probe over your part to form a single line of data points. When you reach
the end of your captured data point line, press the <space bar>, this will create a
feature in the inspection report. Next, remove the lock and move to a new location
and reset the lock repeating the drag operation to create a parallel set of data
points.
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Performance Considerations using GeoTracer

The quality of the data points can be affected by the speed of the CMM while
capturing the data points. A CMM interface captures the XYZ scale values based
on a timed cycle. Some interfaces cycle 30 times or more per second, such as the
Helmel ProCounter series. At this cycle speed you will capture a consistent set of
data points while dragging your hard probe at normal speeds between 2" (51mm)
and 5" (127mm) per second which translates to capturing approximately 20-50
points per second.

If your CMM interface cycles at a lower rate, such as most interfaces on Direct
Computer Control (DCC) CMMs, the cycle can be slowed down to as little as 3
cycles per second. On this style CMM the actual reading of the XYZ scales is
performed by the motion controller and forwarded to the host measuring software
as a status update. At the slower cycle rate, the drag speed required to produce a
uniform set of data points must be reduced to speeds around 1" (25mm) per
second.

Should the drag speed be too fast the spread between data points will be greater
than the requested distance set in the GeoTracer Parameters. If you find
undesirable results in the spread of your data points, slow down the drag speed.
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Cardinal Spline

A cardinal spline is a series of
individual curves between points
joined to form a larger curve. The
spline is specified by an array of
points and a tension parameter. A
cardinal spline passes smoothly
through each point in the array; there
are no sharp corners and no abrupt
changes in the tightness of the curve.
By passing through every point, there
are no missed points that can cause
errors when fitting a surface over the
splines.

The tension of a cardinal spline
determines the fitting of each curve
section in regards to the data points.
The range for the tension value is 0.0
to 1.0 where 1.0 would deliver
straight lines between the data points
and 0.0 would produce the most
flexible curves fitted through each
data point.

Starting the Cardinal Spline Tool

The Cardinal Spline feature works on data clouds captured through the various
scanning methods available in Geomet Junior. To activate the feature, locate the
data cloud feature in the inspection report and highlight it using the left click of
the mouse. Then right click to bring up the sub menu. Locate [Cardinal Spline] in
the list and click on it.
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Setting the Cardinal Spline Parameters

Cardinal Spline Setup Tool

There are three parameters used to tune the fitting process for splines. These are:
Tension, Grid Distance and Location Filter. Understanding these parameters will
greatly enhance your success in creating splines from data points.

Tension Parameter

This value controls how the spline is fitted between the data points. The valid
range is 0.0 to 1.0 where 0.0 produces the largest radius between data points and
1.0 will produce straight lines between data points. We recommend that 0.0 be
used as a default.

Grid Distance

This is the setting used when the original data points were scanned. Geomet
Junior carries it over from the scanning operation. However, on earlier Geomet
Junior systems, this value was not included in the original scan features and
should be entered manually.

When applying Cardinal Splines to data clouds that do not conform to a uniform
row / column configuration, undesirable results may occur. In this condition,
Geomet Junior allows the selection of "Create Single Curve" and "Force Fit"
which is explained later in this document.
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Location Filter

Geomet Junior starts building rows and columns first by sorting the data points
into row and column order. The location filter is applied when Geomet Junior
moves down a column and ‘looks’ for the next data point. For example: if the
column has a start point with a "Y" value of 1.000", it would look down the
column and expect to find the next point also with a "Y" value near 1.000". Since
scanning operations do not deliver exact position, the data point under the start
point might have a "Y" value of 1.012". The Location Filter is a factor of the grid
distance where 0.15 would yield a search zone of 0.15 * Grid Distance (0.15 *
0.05 = .0075). This value determines the zone around the original "Y" value of
1.000" and the column sorting would not include the next point at 1.012.

In data clouds that have well-defined row and column structures, the Location
Filter can be low, such as 0.25. In poorly defined patterns, use a value between
0.5 and 0.9.

When the value is set too high, the splines created can "jump" to neighboring
points from other columns.

Spline Fitting and Display Options

Under the group designated as "Spline Fitting and Display Options", you can
establish the spline methodology and fitting behaviors.

Create Single Curve

This option will take all your data points without regard to rows and columns and
fit the curves through each point in the same order as the points were captured.
This option is designed to work with data points captured with GeoTracer where
you capture data points in a line with distinct start and finish end points. When
this option is checked, the display and export of one spline for this feature will
occur.

Rows / Columns

Row and Column selections are available when Single Selection is not chosen.
They are designed to work with data points gathered under the automatic scanning
tools in Geomet Junior. These scanning tools capture the data points in organized
Row and Column formations that can be extracted to deliver uniform splines.
When selecting Row and/or Columns, Geomet Junior will attempt to build
straight lines in the XY plane of the captured data points. Then rows and columns
are extracted and used to form the splines. It is important that these rows and
columns are organized in controlled positions. See Setup Parameters above.
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Force Fit

This option is used when Rows and Columns are active. When calculating, some
data points might be skipped if they do not fall within the parameter settings. This
can cause a row to contain 2 or more splines. When selecting Force Fit, all data
points identified in the row or column will be used to fit one spline. Another use
for Force Fit is when there were exclusion zones used in data point scanning. This
will fit the spline over the exclusion zone.

Closed Path

When this option is checked, Geomet Junior will attempt to close the path from
the last data point to the first.

Data Point

When selected, this option will display the complete set of data points in addition
to any splines selected for showing.

Export Options

These options, combined with Spline Fitting and Display Options control the
export characteristics. The selections of Row and Column for export are available
when Create Single Curve is NOT selected. NOTE: selecting Row and Columns
in the Display group does not automatically create exported rows and
columns!

NOTE: Cardinal Splines is exported in the IGES format only!

Rows

This selection will create and export splines derived from the data points that
conform to rows. The rows exported are controlled by the selections of Force Fit
and Closed Path.

Columns

This selection will create and export splines derived from the data points that
conform to columns. The columns exported are controlled by the selections of
Force Fit and Closed Path.

Data Points

This selection will export the data cloud in addition to any row and column
selection already made.
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Executing the Cardinal Spline

Once the parameters have been set, highlight from the list of data clouds the
features you want the Cardinal Spline function to work with. Process the request
by press <Ok> to build the Cardinal Splines.

Captured Data Points Fitted Cardinal Splines

The illustration above shows the application of Cardinal Spline to a raw set of
data points that have been captured with Radial Boundary Contour using a grid
spacing of 0.020".

Removing Cardinal Splines

To remove the Cardinal Splines from a feature, highlight the feature and press the
<Remove Spline> button.
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Exporting

Menu: File ⇒ Export ⇒ Export

Geomet Junior can export features and data points in three formats.

ASCII and DXF: Exports data point clouds and 3D Point entities. On features,
such as a circle, only the data points used to calculate the feature would be
exported.

IGES: This format exports all features based on the following table.

Summary of IGES Supported Features
Type Definition
100 Circular Arc Entity
104 Conic Arc Entity
108 Plane Entity
110 Line Entity
116 Point Entity
126 Rational B-Spline Curve Entity
128 Rational B-Spline Surface Entity
144 Trimmed (Parameteric) Surface Entity
158 Sphere Entity
190 Plane Surface Entity
196 Spherical Surface Entity
504 Edge Entity
508 Loop Entity
510 Face Entity
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Exploring the Export Tool

The Export Tool displays a feature list of your current inspection. This list can be
sorted between Part Number or into common feature groups such as Circle and
Planes.

Sorted by Feature Number Sorted into Groups Selecting by Groups

Selecting Features for Exporting

Selecting features can be done in a random fashion or by using <Select All>.
When sorted by Feature Number, the selection process is accomplished on a
feature-by-features basis by placing a check next to the feature. When sorted by
Groups, the selection process can be done on a single feature basis by expanding a
group using the < + > button and checking the feature. To select all features
within a group, place a check next to the group name.

Setting the Decimal Precision

Setting the precision is done through the <Configure> button. Always set a
reasonable precision that will allow a well-defined exported feature. The default
for this value is 5.

Basic Export

With the selection of features, you can now proceed
to the export function. Press <Export> and the
standard Windows Save-As dialog will appear.
Locate the folder and assign a file name to your
export and press <Save>.
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Enhanced Export Tools

There are two options available that will enhance the
exporting of features. These options control the Part
Coordinate System during the export process.

Under normal conditions, all features are exported in the
original position within the CMM envelope, commonly
referred to as the Machine Coordinate System. All
features will retain the position and orientation to other
features and in most cases this is sufficient. However, you
may want to export into a specific PCS making the
position and orientation local to the inspected part.

Specify Target PCS: This option allows a PCS to be specified that all features
would be projected into. This is commonly used when you want a coordinate
system locally on your part. When exported the misalignment to the MCS is
removed and the exported features are aligned true to the selected PCS.

Merge into Target: This option allows merging of all features that were
originally built in other PCSs into a common PCS for export. The result is an
assembly that can combine all features into a single file. Those features may have
been measured on the side, bottom or any orientation on the part.
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Multi-Point Feature and CMM Inherent Errors:

Applies to: All Levels of Geomet Junior
Last updated: Monday December 13, 2005.

NOTICE
Information contained within this document is subject to change without notice.
No part of this document may be reproduced or transmitted in any form or by any
means, electronic or mechanical, for any purpose without written authorization
from Helmel Engineering Products, Inc.

This document contains proprietary subject matter of Helmel Engineering
Products, Inc. and its receipt or possession does not convey any rights to
reproduce disclose its content or to manufacture, use or sell anything it may
describe. Reproduction, disclosure or use without specific written authorization of
Helmel Engineering Products, Inc. is strictly forbidden.

© Helmel Engineering Products, Inc. 1985 - 2006. All right reserved.

GEOMET®, MICROSTAR® are trademarks of
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Introduction

Technical Note #2 - Multi-Point Feature Inherent Errors
Published October, 14, 2003

Edward R. Yaris - Software Development Manager,
Helmel Engineering Products, Inc.

Commonly found Errors

• CMM Calibration Errors
• Probing Errors
• Operator Influences
• Data Point Spread

System Errors

In all multi-point features, the ability to report accurate and repeatable results are
subject to the quality of the gathered data points. Influencing your measured
results will be the stacking of inaccuracies within your measuring system
generated by the commonly found errors listed above.

Coordinate Measuring Machine

Scale Error
The CMM has inherent inaccuracies such as axial linear error and mechanical
limitations on squareness, parallelism and perpendicularity. Every CMM has a
scale attached to each axis of movement. This scale can be a mechanical / optical
or laser configuration. In the case of a mechanical / optical there exists positioning
error which CMM manufacturers will attempt to compensate for through
hardware or software.

For example when a scale is installed, it will be compared to a master scale or
laser. The CMM will be positioned along the scale at different points and the
reported position will be compared to the master. If the position reported by the
laser was 10.00000 and the CMM reported 9.99875 The difference will be the
linear inaccuracies of the scale at that position. In a single linear compensation, a
scale factor will be applied to the CMM’s position feedback to correct for the
error. However, this method of compensation works with the overall average and
does not correct for local inaccuracies along the scale.
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Single Variable Linear Scale Compensation

Figure 1 demonstrates the Position Error measured compared to a Master Scale or
Laser. The scale along the left side illustrates the deviation error.

figure 1, Original Position Error figure 2 – Single Linear Compensation

After single line compensation has been applied the deviation error has been
minimized to create a more accurate position.

One limitation in single line compensation is that the variances along the scale
can not be individually removed. Therefore the single line compensation method
only averages out the entire scale without regard to multiple position errors. When
the CMM is positioned along the scale, some error characteristic will still be built
in.

Non-Linear Scale Compensation

Another method to minimize scale-positioning error is the Non-Linear method.
This method builds a table of compensation values that can be measured and
created along the various undulations along the scale. It requires that the CMM
has a reproducible home position for all axes. The chart below illustrates a non-
Linear method applied to the same scale shown above. The error has been reduced
further.

figure 3, Non-Linear Compensation Applied

As with any linear compensation method, if the scale is not mapped out over
every position, then an error will always be present influencing your results.
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Mechanical Intrinsic Accuracy

The next error that a CMM can have is called intrinsic accuracy, the mechanical
accuracy of the CMM. These include Squareness, Perpendicularity and
Parallelism of the structure of your CMM. If the X-axis is not perpendicular to the
Y-axis, then when the probe is moved along the X-axis a deviation in Y will
occur. To test for this, place a certified square down on the CMM base. Place a
.0001” or better indicator on the probe bar and lock the Z and X-axes from
moving. Move the CMM in the Y-axis with the Indicator in contact with the
square. Set the square edge parallel with the Y-axis travel until no movement is
shown on the indicator. Unlock the X-axis and reposition the indicator so it
contacts the square and lock the Y-axis. Move the indicator along the X-axis and
you should not see movement on the indicator dial.

Repeat this procedure in the front and back location on your CMM to ensure the
X to Y-axis relationship is perpendicular thoughout the measuring envelope. An
additional test would be to raise the square to the highest point within your
measuring cube and repeat the procedure.

Should you see a deviation, then your CMM is not square in the XY plane. Any
measurements taken will have an inherent inaccuracy.

The Z-axis should be perpendicular to the CMM base. To test this, place a .0001”
or better indicator on the probe bar. Place a certified square on the CMM base
with the surface parallel to the Y-axis. Lock your X and Y-axis with the indicator
in contact with the square. Move your Z-axis up and down, you should not see
any movement on the indicator. Now repeat the test with the surface of the square
parallel to the X-axis.

Should you see a deviation, then your CMM is not square in the ZX and / or YZ
plane. Any measurements taken will have an inherent inaccuracy.
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Ball Bar Test for CMMs

One method to accurately evaluate axis to axis relationships is found in the
B89.4.1, Methods for Performance Evaluation of Coordinate Measuring Machines
published by ASME International. This Standard establishes requirements and
methods for specifying and testing the performance of coordinate measuring
machines (CMMs) having three linear axes perpendicular to each other and up to
one rotary axis positioned arbitrarily with respect to these linear axes. In addition
to clarifying the performance evaluation of CMMs, this Standard seeks to
facilitate performance comparisons among machines by unifying terminology,
general machine classification, and the treatment of environmental effects.

The Ball Bar consists of a temperature-stabilized bar with two high precision
spheres mounted at each end, see figures 4 and 5. The length between the spheres
is not necessary to be known. In the B89.4.1 specification there is a recommended
length based on the size of the CMM. The Ball Bar is positioned within the
measuring area of the CMM in 28 different positions as described in ASME
B89.4.1.

figure 4, Ball Bar Test Set figure 5 – Shown in Evelated State

The process of gathering data involves the measuring of each sphere and
calculating the direct line distance between them. One advantage of this method
over other methods, such as a step gage, is the averaging effect of the probe lobe
errors. In any given direction around the traditional touch probe, there exists a
lobing error that can be measured, but not effectively removed from a feature
calculation. By capturing data points evenly around the sphere, the lobe error
variations are not removed, but averaged out to obtain a closer size and location
reporting of the actual sphere.
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Once all 28 positions have been calculated, they can be entered in an Excel
spreadsheet. The average of all 28 positions is first obtained and a companion
column of actual - average is calculated. These values are then plotted, as shown
in figure 6.

figure 6, Ball Bar Results

The Maximum and Minimum values are found from the deviation column. The
spread between these values is considered the working tolerance. This value is
often reported as the volumetric accuracy of a CMM. It should be noted that the
length of the ball bar is often a small fraction of the actual measuring area.
Therefore, the reported working tolerance only reflects the area the cubic size of
one ball bar length in the X, Y, and Z and should not be used to define the entire
CMM.

figure 7, X / Y Squareness Deviation

In figure 7, we can visualize how to interpret the Ball Bar tests. We can see the
direct effect of a squareness deviation of the X versus Y-axis. The measured
distance of the lengths, d1 and d2, should be equal when the CMM has been
properly setup. As the illustration shows, d1 being greater than d2 which
demonstrates that the relationship between the X and Y-axis are not
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perpendicular. When properly interpreted by a trained calibration engineer, all 28
positions will effectively provide a picture of the intrinsic characteristics of your
CMM.

Many CMM manufacturers have abandoned building intrinsic accuracy in favor
of 3D software compensation. This allows building of a CMM with little attention
to the accuracy of the assembly. The accuracy is acomplished by mapping the
CMM with a known standard, such as a laser, then providing 3D compensation
algorithms to correct the inherent errors. However using only a laser does not
remove all the inherent inaccuracies within the entire measuring cube.

There is no correct answer as to which method delivers a more accurate CMM. In
both cases, the ability to perform field calibrations often becomes an economic
cost the user must absorb. To perform a field calibration by mapping the CMM
with a laser system is a higher cost than adjusting for intrinsic accuracy.

Probe System Errors

Every probe system introduces inaccuracies to
your data point gathering. These include capture
speed, lobe errors, stylus lengths and probe
contact pressure. Understanding the errors within
the probe system can be very difficult. Most
electronic touch probes have no index position
when installed on a CMM and can rotate to a new
location moving the lobe error. Additionally,
electronic touch probes are a simple switch and
can not determine the approach vector at the point
of contact. This simple fact makes it very difficult
to map out probe errors. figure 8, Lobe Error Example
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Lobe errors are mechanical limitations to the probe head. Lobes can have an error
in excess of .0001” deviation when capturing a point moving at 0° compared to
capturing a point at 60°. As shown in figure 8, the lobe error pattern is
triangulated based on the mechanical layout of the kinematics probe alignment,
see figure 9. The touch probe can be described as having low and high force
directions when capturing a trigger, see figures 10 and 11.

figure 9, Force Direction figure 10, High Force Direction figure 11, Low Force Direction

Stylus lengths will add additional error to your system. A short length of about
10mm will not influence your data points, however a 100mm length will increase
the error 10 fold to the lobe deviation. If you need to extend your stylus, we
recommend the Renishaw PEL family of extensions. These are extensions that
mount between the probe head and probe body.

When the Trigger Force pressure is set too high, the probe error will increase
exponentially! Most mechanical probes allow you to adjust the tension applied to
the trigger mechanism, see manufacturers technical manual. Some touch probe
models, such as the Renishaw TP20, offer interchangeable modules with a preset
trigger force. By increasing the pressure, you force the probe to trigger at a higher
pressure that introduces stress and deflections in the stylus tip and extension.

Strain-gauge or piezo designed probes, such as the Renishaw TP200, minimizes
the lobe error by eliminating the mechanical kinematics design. However, these
gauges are susceptible to speed changes and the actual contact speed should be
stable and consistent. Probes that use this technology should not be considered for
manual CMMs.
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Operator Influences

Finally the operator will provide the greatest error. If the operator captures data
points with an inconsistent speed, repeatability errors are introduced. To test for
speed difference, lock the Z and X-axes on your CMM. Place a part on your
CMM and measure a +Y point. Increase the speed at which your capture points.
At a certain speed you will begin to see variances in the reported results.

Other operator related issues include where you hold the CMM. If you have a
large CMM, probing while holding the probe bar just above the probe will act
differently that when you are holding as far up the probe bar as possible. The
probe bar is a lever, and by moving that lever you are placing strain on the
superstructure of the CMM. If you gather data points before the CMM has
‘settled’ you will get unreliable data points.

Data Point Spread

When measuring multi-point features, how you spread the data points will be the
single greatest influence on the accuracy and repeatability of the feature. For
example, if you capture data points on a circle using only a 15° sweep, the results
are unreliable and not repeatable. If those same points were captured over a 300°
sweep, the results would be accurate, see figure 12. The same holds true for
Planes spheres, cylinders and cones. Cylinders and cones require a proper spread
over the length otherwise the axis of the feature will not be reliable.

Arc(Degrees) Center Error Radius Error
180 0.00014 0.00000
120 0.00028 0.00014
90 0.00048 0.00034
60 0.00104 0.00090
30 0.00409 0.00395
20 0.00914 0.00899
10 0.03549 0.03535
5 0.12823 0.12810

figure 12, Circle Errors

Imagine capturing two points on a line only .25” apart with a probing error of
.0001”. The resulting line would have a repeatability error of .040” over 5.000” or
0.4584 degree! If that line were used as part of the Part Coordinate System, then
all subsequent features would have questionable accuracy.
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